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Several modules must contain data before the system can become fully operational. The following 
section details the initial data entry steps. The following information assumes that your hardware and 
network is operational. 

Initial data entry includes static data, which is loosely defined as “information that does not normally 
change on a day-to-day basis.” This kind of information includes some of the following: 

▪ GL Chart of accounts, (See Accounting Setup in the Accounting Manual) GL Year and Period 
Maintenance, System Parameters, Terms, Tax Codes, Cost Elements) 

▪ System Parameters and Lists, (See Setting up the System Parameters) 

▪ Customers (See Customer Maintenance) 

▪ Vendors (See Vendor Maintenance) 

▪ Raw Materials (plastics, blends, inserts, packaging) (See Inventory Management) 

▪ Costing values (labor rates, markup tables--if the quoting package will be used) 

▪ Work Centers 

▪ Shop Calendar 

▪ Manufacturing Configurations (BOM-Manufacturing Configurations in the Manufacturing Manual). 

These items should be entered in the order listed. Completing the entry of the manufacturing 
configurations is a pivotal moment in EnterpriseIQ. Once created, the user can begin order entry, 
shipping, invoicing, scheduling and all other activities that revolve around the part number created. 

Coding Systems 

The one common element these items have is that they all require a coding or numbering system to 
identify each unique item. For example, all customers need a customer code. Further, Inventory items 
use both an item code and a description. 

Note: DELMIAworks recommends not using % in fields that can be searched on. This is a reserved 
character used for wildcard search in both Oracle and Delphi. 

Note: Data copied and pasted from Excel can cause issues. 

 
 

Initial Data Entry 
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Manufacturing Types 

`There are several default Manufacturing Types in EIQ. Below is a list with a brief description of each: 

ASSEMBLY  Similar to Generic BOM except Cycle Time on BOMs is in Hours instead of 
Seconds. 

Note: The Cycle time for the Assembly Mfg Type in the Estimating module is in 
seconds and not hours. When converting an Assembly manufacturing type Quote 
to BOM the system will convert the cycle time to hours. 

ASSY1 Utilizes BOMs with processes attached that call out work centers, tools, labor and 
quality requirements. Uses Assembly Track and Assy Data for reporting and 
tracking. Labor reporting is done for each process and components are 
backflushed during labor reporting. 

ASSY2  Same as ASSY1 except Work Centers are associated to the processes, and to the 
Assembly Line. 

ASSY3 Similar to  the other ASSY types except an Assembly Line is associated to the 
BOM, and by default, Final Assembly is used to report production. 

(Please see the ASSY Manufacturing documentation for more details on these 
MFG Types). 

BLOWMOLD  Similar to Injection BOM except Runner/Sprue is changed to "Parison/Flash". 

COMPLEX  Similar to Generic BOM except it has an icon to Designate Child Complex BOMs 
(this brings up a window called "Complex Visual BOM" where you can enter in 
additional info). Designed to simplify the scheduling process where multiple WO’s 
are involved in producing a product and they are done on multiple work centers 
that make up a complex line. When a WO for the complex BOM is set up in first 
position on the Complex Line, all child work orders will automatically also be set 
up on their work centers in the line. (See Complex MFG Type BOMs for more 
information). 

COMPOUND1  The Compound1 manufacturing type is used to create items with a unit of 
measure based on a weight such as grams or pounds. This manufacturing type is 
similar to Extrusion2 where there is a Lbs/Hr field, however there is no primary 
material. The item produced is made up of several components which also must 
have a weight type unit of measure. The components are assigned on the item 
details tab similar to the Masterbatch manufacturing type. (See Compound1 for 
more information). 

DIECAST  Similar to Injection except Runner/Sprue is changed to "Runner/biscuit". 

EXTRUSION  Item is Part Length with a typical unit of measure in feet. The BOM includes 
Feet/Lb and Lbs/Hr. Production is reported as a total length. (See Extrusions - 
General BOM Information for more information on the Extrusion MFG Types). 
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EXTRUSION2  Item is in part weight with a typical unit of measure in pounds. The BOM includes 
Lbs/Hr. Production is reported in total Lbs. 

EXTRUSION3  Item is in part weight with a typical unit of measure in eaches. The BOM includes 
Lbs/Hr. Production is reported in total parts. 

GENERIC  The most basic BOM structure used for manufacturing that does not fit any of the 
other more specific types. Like other standards, generics can consume finished 
goods, components, and packaging, and can include labor and overhead. (See 
Generic Standards for details). 

INJECTION  Primary material, tooling info, cavitation and part weight information. (See 
Creating a New BOM for details). 

JOBSHOP  Designed for toolmakers, die makers, and other short run, discrete manufacturers 
utilizing Generic BOMs. It provides visual routing and fast creation of new 
projects based on existing routing templates It simplifies production based on 
longer run times and tiered manufacturing processes, including coring, lathing, 
drilling, grinding and milling. It’s recommended to have a  separate EPlant for 
handling JobShop parts separate from regular manufacturing processes. For 
JobShop, you create a new project from the JobShop module and then build out 
the routing info with a BOM set up for each step in the routing process. (See the 
JobShop documentation for more information). 

JOBSHOP2  Similar to JobShop in that it is designed for toolmakers, die makers, and other 
short run, discrete manufacturers. This is based on the ASSY1, ASSY2, or ASSY3. It 
brings together the JobShop module and Assembly Track in one place. (See the 
JobShop2 documentation for more information). 

MBATCH  The Masterbatch manufacturing type is used to create items with a unit of 
measure based on a weight such as grams or pounds. The item produced is made 
up of several components which also must have a weight type unit of measure. 

▪ Item details tab has icon to add components based on quantity or percentage 
instead of calling out for a primary material (similar to Compound1).  

▪ Production Summary info for "Batches/Hr" and "Hours/K Batches".  

▪ Cycle Time is called "Batch Time", Actual and Standard Cavitation is called "Act 
Batch Size" and "Std Batch Size", no Part Weight 

(See Masterbatch MFG Type for details). 

OUTSOURCE  For Outsource operations. The Center Type is changed to "Vendor" and Cycle 
Time is changed to "Days/K" (days required to get 1000 parts), there are also 
fields for a "Flat Ratio" cycle time and "Drop Ship". There’s no Tooling or 
Production Summary data. (See Outsourcing below for details). 

PM  No BOM’s are created for this MFG Type. It is used if you wish to set up PM Cells 
for using the PM Capacity Schedule tool. The PM MFG Type is only used in 
Maintenance, Repair and Overhaul. It will not be visible in BOMs, Work Centers, 
Scheduling, Production Reporting, and RealTime. (See the Maintenance, Repair 
and Overhaul help file for more information). 
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REWORK  Same as Generic BOM. Used in conjunction with creating RMA rework work 
orders for Rework type work centers. (See Mfg Rework Order for details). 

RIM  Similar to an Injection BOM except Runner/Sprue is called "Flashing". The cycle 
time defaults to minutes and not seconds. Shift Backflush can only be "Based on 
total cycles at shot weight. The Eff Factor is called "Yield Factor", Production 
Summary also has a "Parts/Hr" value. 

ROTATIONAL  Similar to Injection BOM except no Runner/Sprue field, and cycle time defaults to 
minutes and not seconds. 

SFOAM  The same as Injection BOM, however in the Work Center module, the Center 
Type is changed to "Platen Type". 

SLITTING Used for slitting rolls of material to specific thicknesses. Similar to EXT1 as it has 
Feet/Lb and Lbs/Hr. (See Slitting for details). 

STAMPING Similar to Injection BOM except Runner/Sprue is changed to "Waste Material". 

TFORM2 Fields for Gauge, SPG, Tool Width, Tool Length, Sheet Weight, and Skeleton 
Weight. Designed for inputting sheets that have native UOM of Each and are 
dispositioned in Each (includes additional fields for Rail and Clamp values). 

 

THERMOFORM  

Fields for Gauge, SPG, Tool Width, Tool Length, Sheet Weight, and Skeleton 
Weight. Designed for continuous feed input. (See Thermoform - General BOM 
Information for information on Thermoform and TForm2 MFG Types). 

THERMOSET  Same as Injection BOM. 

TREATMENT This manufacturing type is used for processes such as heat treatment and 
annealing where multiple items are processed at one time. All items that require 
a specific Treatment are included in the BOM. 

ASSY vs. Generic Comparison 

MFG 
TYPE 

WORK 
CENTERS 

BOMS PROCESS/ 

OPERATIONS 

SCHEDULING PROD/LABOR 
REPORTING 

ASSY 
1 

Work 
Centers 
are 
associated 
to the 
processes 

Processes are 
added to the 
BOM 
(required) 

Process 
(required)  
contain Center 
Types, 
Materials, Cycle 
Times, Yield, 
Labor, etc.  

Work Orders/ 
Processes  are 
added to ASSY 
Track, and Finite 
Scheduling 
(optional) 

ASSY Track, or ASSY 
Data;  backflushing is 
done when Process is 
completed. FG item is 
added to inventory 
when Final Reporting is 
done.  
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ASSY 
2 

Work 
Centers 
are 
associated 
to the 
processes 
and      
Assembly 
Line 

Processes are 
added to the 
BOM 
(required) 

Process 
(required)  
contain Center 
Types, 
Materials, Cycle 
Times, Yield, 
Labor, etc. 

Processes are 
scheduled    on 
work centers in  
scheduling similar 
to    ASSY1  

ASSY Track, or ASSY 
Data;   backflushing is 
done when Process is 
completed. FG item is 
added to inventory 
when Final Reporting is 
done. 

ASSY 
3 

Work 
Centers 
are 
associated 
to the 
processes 
and      
Assembly 
Line 

Processes are 
added to the 
BOM 
(required);  
Assembly Line 
is    
associated to 
the BOM 

Process 
(required)  
contain Center 
Types, 
Materials, Cycle 
Times, Yield, 
Labor, etc. 

Work orders are 
scheduled on work 
centers in Finite 
Scheduling 

ASSY Track, or ASSY 
Data; Components are 
backflushed at Final 
Assembly by default. 
Optionally, components 
can be backflushed 
when reporting labor 
instead of at final 
assembly if the 
'Backflush Each Process' 
option is checked for the 
MFG Type. 

GENE
RIC 

Work 
Centers 
Types are 
associated 
to the 
BOM 

Required 
fields include 
center type, 
cycle time 
(seconds); 
optional fields 
scrap%, labor, 
and eff % 

Operations are 
additional 
steps;  can 
include cycle 
time and rate, 
and are 
optional 

Work orders are 
scheduled on work 
centers in Finite 
Scheduling 

Prod Rep by Shift / PRLS 

Prod Rep by WO 

PRA 

ASSE
MBLY 

Work 
Centers 
Types are 
associated 
to the 
BOM 

Required 
fields include 
center type, 
cycle time 
(hours); 
optional fields 
scrap%, labor, 
and eff % 

Operations are 
additional 
steps;  can 
include cycle 
time and rate, 
and are 
optional 

Work orders are 
scheduled on work 
centers in Finite 
Scheduling 

Prod Rep by Shift / PRLS 

Prod Rep by WO 

PRA 

 

Compound vs. Masterbatch 

MFG TYPE COMPOUND MASTERBATCH 



Initial Data Entry Page 8 of 91 

 

Cycles Based On / Cycle 
Time 

Lbs/Hr Batch Time in Secs 

Item Details > Item Info Item Weight > Lbs / Gr / Oz Std Batch Sz / Act Batch Sz 

Assign Batch Components By Percentage / By Qty & % / Parts 
Per 

By Percentage / By Qty & % / Parts 
Per 

Production Reporting  Total Cycles X Batch Size = Good 
Parts (Lbs) + Reject (Lbs 

Total Lbs = Good Lbs + Reject Lbs 

Modify or Add MFG Types 

To modify or to add additional manufacturing types, follow the steps below. 

➢ From the EIQ Launcher Bar, click on File|Manufacturing|Mfg Setup|Mfg Type. The Modify 

Manufacturing Types screen will appear. 
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➢ Highlight the Mfg Type to modify and make the change. 

➢ If adding in a new type, click on the ADD [+] function key located on the Navigator bar. 

➢ From the Select Mfg Type form choose the Predefined or User Defined tab.   

Predefined - This tab is used to add predefined manufacturing types available in the system. Select the 
drop down list and choose from the supported manufacturing types. 

User Defined - This tab is used to create user defined manufacturing types. Enter the name in the Mfg 
Type field (apostrophes are not allowed) and select the manufacturing type the user defined type should 
default to from the drop down list of system supported manufacturing types. Once the manufacturing 
type is selected, the options on the right side of the MFG Types screen  will be updated based on the 
selected default type. To function properly the predefined type the user defined type is based on must 
be active in the MFG Type list for non ASSY types. When a user defined type ASSY manufacturing type is 
created without having the predefined ASSY type created, the system will still make the Assembly Track 
and Assembly Process Maintenance modules visible after logging back in. 

Note: When naming multiple user defined manufacturing types, ensure that the names are unique in 
ways other than just special characters (for example, not “TYPE#NAME” and “TYPE/NAME”).  This will 
ensure that the different types will be able to have their own User Defined Forms associated with them.  

Notes:  

Once BOMs are created using the user defined manufacturing type the default type cannot be changed.  
If BOMs have not been created and the user wants to change the ‘default to’ type, the user defined 
manufacturing type will need to be deleted and then recreated. 

If a user does not select a 'Default To' MFG Type, it will default to Generic. 

If a user attempts to create a user defined manufacturing type with the same name as a predefined 
manufacturing type a warning will appear stating, "This is a standard mfg type and is not available to 
utilize in a User Defined mfg type." 

When naming multiple user defined manufacturing types, ensure that the names are unique in ways 
other than just special characters (for example, not “TYPE#NAME” and “TYPE/NAME”).  This will ensure 
that the different types will be able to have their own User Defined Forms associated with them. 

Reports Names Tab: 

Assign the appropriate BOM and WO reports by clicking on the search button to right of these fields. The 
BOM and WO reports can be EPlant specific if desired. Select the EPlant ID and then select the report 
using the search button. When generating reports using speed buttons in the BOM or WO module, the 
report that prints will be based on the EPlant the user is logged into. 

Labor/Overhead Tab: 
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Set the labor and overhead cost element associated with the manufacturing type.  

➢ Default Labor Rates - Default Labor Rates may also be setup from within this screen as well. 

These rates can be overridden when setting up a manufacturing configuration by clicking on 
Options|Misc. Parameters from within the BOM screen or by utilizing the employee levels in the 

labor field of the BOM. Rates can be set for Current, Future, Budget, and Forecast. If these 
costs are populated, the system will use these instead of the current cost for calculating the 
applicable cost such as Future Cost.The same cost elements assigned to the center type will 

be used for these calculations. 

➢ Labor posted from Time & Attendance - When checked the labor will not post to translog from 

floor dispositioning. Labor will be posted from Time & Attendance only. When floor 

dispositioning the system will not put an actual cost into the translog for labor for that 
manufacturing type.  It removes the actual labor entry from the floor disposition/backflush 
routine so that only actual labor is picked up in PIT from the Time and Attendance records. 

If it is not checked and labor is reported using Time and Attendance there will be a double 
hit to labor. Note: During production reporting the employee hours information can only be 
edited if the user has security rights to do so. A Status Exception will appear stating “Mfg 

Type is setup to have labor posted from Time & Attendance”. By default, if users enter labor 
in production reporting it will post to translog, therefore Time and Attendance users should 
not enter labor in production reporting. 

▪ Include Manual Labor from PRS - If the 'Labor posted from Time & Attendance' option is checked 
this option can also be checked to include manual labor information from Production Reports by 
Shift (PRS). If the 'Labor posted from Time & Attendance' option is not checked this option will be 
grayed out. When checked it allows users who do not have Time & Attendance setup for all 
EPlants to still report labor from PRS. This can also be checked at the MFG Cell level. When 
determining if manual labor should be included from PRS the system will look at the MFG Cell 
first using the hierarchy below: 
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If 'Include manual labor from PRS' is set as 'Yes' on the MFG Cell the system will include both 
manually entered labor and labor posted from Time & Attendance.  

If the MFG Cell is set to 'N' the system will not include manual labor from PRS.  

If this field is not set at the MFG Cell level the system will use what is set for the MFG Type.  

 

Note:  When 'Labor posted from Time & Attendance' is checked and 'Backflush on Clock Out' is also 
checked, when clocking out and reporting zero good parts, only Labor hours, the Actual Cost is updated 
to include the Actual labor dollars recorded for all labor reported.  This Actual Cost will be updated on 
the Location when parts are put in to inventory, and captured in IACJ.   

Note: When the ‘Labor posted from Time & Attendance’ is enabled on the MFG Type and the 'Include 
Manual Labor from PRS' is not checked, if a user manually adds labor to the Employee Hrs on the 
Production Report, the user will need to close the production report and go to Task Clock Maintenance 
to post those manually added labor records before dispositioning the production report. 

➢ Use Labor Rate to calculate Actual Labor - If this option is checked, when calculating actual labor 

in Actual Costing, instead of using the employee charge rate, the system will use the Mfg 
Type Labor Rate. The calculation is (Mfg type labor rate * Production Hours)/Quantity. 

➢ Variable Overhead - The calculation for Variable Overhead can be Work Center Based or Labor 
Based. If 'Work Center Based' is selected, standard and actual overhead will be calculated as 
usual using the center rate. If 'Labor Based' is selected with a rate filled in then the standard 
and actual overhead costs will be based on the labor rate entered for the manufacturing 

type. If a rate is not filled in, the overhead will be 0. See Standard Cost Calculations - For 
Non Extrusion MFG Types in the Accounting manual for additional information. 

➢ Variable Overhead generates its own IACJ file - its header references the Variable Overhead 

Translog record. Users can drill down in IACJ to view further details. 

➢ Fixed Overhead - A Fixed Overhead Cost Element can be assigned to the MFG Type. When the 

Overhead is work center based the system will use the rates associated to the work centers. 
If the overhead is labor based, enter the rate in the Fixed field. Note: The Labor Based Rate 

Fixed rate is not currently used in an Engineering Quote calculation for Prod Cost.  The 

Variable rate can be used. 

Fixed Overhead generates its own IACJ files - its header references the Fixed Overhead Translog record. 
Users can drill down in IACJ to view further details. 

➢ Overhead Posted from Time and Attendance - This option is only available when the option 'Labor 

Posted from Time and Attendance' is checked and 'Work Center Based' is not checked. With 

this option enabled, an Overhead record is posted to the Translog (Transactions Log) along 
with the Labor record.  

➢ The Total Calculated Hours are used for the Variable Overhead Quantity. If the Work Order 

is scheduled when the Labor record is posted, the Variable Overhead will post as the 
following:  
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➢ (Calculated Labor Hours) * (Variable Overhead Center Cost of the Work Center on which the 

Work Order is scheduled) 

➢ If the Work Order is not scheduled when the Labor record is posted, the default rate 
currently set in the MFG Type -> Labor/Overhead -> Labor Based Rate -> Variable field will 

be used:  

➢ (Calculated Labor Hours) * (MFG Type Labor Base Rate Variable Overhead Cost) 

➢ This feature also applies to PRW (Production Reporting by Work Order). Since both the 

Labor and Overhead Translog records have the same batch and sub batch records, they are 
linked in Post Inventory Transactions (PIT). However, the Labor and Overhead records will 
not display in PRW when they are posted - they will only display in PIT.  

➢ The following hierarchy will be used to capture Overhead cost elements. 

▪ Cost Element on the Work Center assigned to the Labor record. 

▪ If no Work Center is assigned to the Labor record, use the Cost Element on the Manufacturing 
Type. 

▪ If no Cost Element is found on the Manufacturing Type, use the Overhead Cost Element(s) on the 
Item. 
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Note:  When 'Labor posted from Time & Attendance' is checked and 'Backflush on Clock Out' is also 
checked, when clocking out and reporting zero good parts, only Labor hours, the Actual Cost is updated 
to include the Actual Overhead dollars recorded for all labor reported.  This Actual Cost will be updated 
on the Location when parts are put in to inventory, and captured in IACJ.  

Note: When 'Overhead Posted from Time and Attendance' is checked, variable overhead is still calculated 
and associated with the correct FG_MULTI record when a clock out occurs and 0 good parts are 
reported. 

Note: When 'Overhead Posted from Time and Attendance' is checked, the FGMULTI_COGS also tracks 
labor and overhead posted from Time and Attendance, so the COGS amounts are still calculated 
correctly. 

➢ Fixed Overhead records will post from Production Reporting and Floor Dispositions as they 
currently do:  

➢ (Number of Parts) * (Fixed Overhead Posted from Time and Attendance) 

➢ If an MFG type does not have 'Overhead Posted from Time and Attendance' checked and 
Task Clock Labor hours associated ot the MFG type are posted from Task Clock IN/OUT 
Maintenance, Variable Overhead will NOT post to Translog. 

➢ If a floor disposition occurs involving an item associated with an MFG type that has both 
'Labor Based Rate' and 'Overhead Posted from Time and Attendance' checked, the Variable 
Overhead will not post to Translog until the Labor record is also posted.  

➢ If an item is associated with an MFG type that has both 'Labor Based Rate' and 'Overhead 
Posted from Time and Attendance' checked, the system does not use the value in the 
'Production Hours' field for the Overhead calculation when the Production Report Line is 

dispositioned because the Variable Overhead record has not been posted to Translog yet. 
The Variable Overhead record will not be posted to Translog until the Labor record is posted. 

➢ If 'Overhead Posted from Time and Attendance' is checked and Actual Costing is enabled, 

whenever Labor records are posted to Translog, Fixed Overhead records are also posted to 
Translog. The Fixed Overhead record in Translog will mimic the Variable Overhead record 
created in Translog whenever Backflush on Clock OUT occurs with Standard Costing 

enabled. The Fixed Overhead Actual Cost posts as the following:  

➢ (Number of Parts) * (Fixed Overhead Cost of the Cost Element's Standard Cost) 

Note: The Fixed Overhead cost is only the top level item's Fixed Overhead Cost - costs of components are 
not included in the calculation. 

Note: The TA_LABOR table holds the Number of Parts records. 

Note: The 'Overhead Posted from Time and Attendance' option is designed to use PRS (Production 
Reporting by Shift and PRW (Production Reporting by Work Order) modules as its reporting methods. 
Attempting to use other reporting methods may result in errors. 
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Note: Labor based overhead is not applicable to the Treatment MFG Type and will be grayed out so users 
will be unable to select this option. 

General Tab: 

➢ Shift Backflush Rules - This option is available for applicable Mfg Types (Injection, Blow 

Molding, Extrusion 1, Extrusion 2, Extrusion 3, Rotational, SFOAM, Stamping, and 

Thermoset). From this setting the user can establish the default Shift Backflush Rule for a 
Manufacturing Type. When creating new BOMs for a Mfg Type with a default Shift backflush 
Rule the system will assign the default rule automatically. The default Shift Backflush Rule is 

also used when converting a quote to BOM for the designated Mfg Type. 

➢ Backflush on Clock Out - If this option is checked when the user clocks out of a task they will 

be prompted with the Floor Disposition screen. From the floor disposition screen the user 

can enter the quantity of parts produced while clocked in to the task. Note: This option 
requires RealTime to tie the floor disposition transactions to Production Reports. For Non RT 
users please see the “Non RT Backflush” option below. 

➢ Non RT Backflush - If the Backflush on Clock Out option is checked the Non RT Backflush 

option becomes available. With both the Floor Dispo and the Non RT Backflush checked 

when the user clocks out of a task they will be prompted to disposition parts from the work 
order they clocked out of and backflush components. This backflush is not tied to the 
production report. The transactions are made in inventory and tied to the labor record. 

➢ Use Yield % on BOM - If this box is checked the BOM 's associated to the MFG Type will say 

'Yield %'  instead of 'Scrap %'. 

➢ RT parts to go based on scans - This option is available for all Mfg Types except ASSY1, ASSY2, 

ASSY3, Outsource and JobShop. If this is checked, a warning message will display, 'You 
must close and reopen the RTServer.exe for this to take effect'. Once RTServer is restarted 
RealTime monitoring parts to go count, as well as any other field calculated from Parts to 

Go, including Shift Parts and Total Parts will not be changed until an RF scan / floor 
disposition transaction is done. Cycles will accumulate, up time, downtime, etc will be 
monitored. Note: Rejects will not affect parts to go.  

Note: For User Defined MFG Types this is a pass through feature from the default MFG Type. For 
example: If the standard Injection MFG Type is checked on RT Parts to Go is based on scans, then all UD 
MFG Types with the default as Injection will decrement by scans and not cycles. 

➢ Include scrap in By-Product weight calc - This option only applies to the Thermoform MFG Type. 

With this option checked if scrap is added to the main form of the BOM, it will be included in 
the by-product weight on the item details tab. 
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➢ Logical Work Center Support - This option only applies to the Injection, Die Cast, Generic, 

Extrusion, Extrusion 2 and Extrusion 3 Manufacturing Types, or user defined types based on 
those MFG Types. This is designed to create logical work centers running multi-position mold 

frames. When this option is checked, on work centers, a tab called 'Change Over' appears. 
Please see the Logical Work Center https://my.iqms.com/cfs-
file.ashx/__key/Technote/Logical_2D00_Work_2D00_Centers.pdf TechNote for 

more information. 

➢ Do not round up dependent demand - With this checked the dependent demand will not be 

rounded up to the next whole number on dependent work orders. If this option is checked, 

the quantities will be calculated and displayed with full decimal precision to mirror the BOM 
Tree explosion. This setting also applies to the 'Explode Forecast' tool in the Forecast 
module. When exploding a Sales Analysis Forecast, the quantity for dependent demand will 

be rounded up to the nearest whole number unless this option is checked for the relevant 
Manufacturing Type. This applies to all MFG Types except MBATCH, JobShop, ASSY1/2/3, 
EXTRUSION2, SLITTING, COMPOUND1, and OUTSOURCE. Important Note: Any MFG Type 

that makes an item in EACH will round, regardless of this setting. 

➢ Std costing calc to consider family tool part weights - This option only applies to the TFORM2 Mfg 

Type. When this is checked the standard cost calculation for TFORM2 items will take into 

account the part weight of each member of the family tool.  The calculation will be very 
similar to the standard cost calculation for the THERMOFORM Mfg Type. 

➢ Add Floor Disposition Out Qty to Calculated Usage - This applies to all Mfg Types except ASSY 1, 

2, and 3. If this is checked the out disposition quantity will be added to the calculated 
material usage during production reporting by shift. If it is not checked it will replace the 

calculated material usage in the production report. Note: This applies only if the work center 
has the 'Floor Actual Material Usage' option checked. 

➢ Use SN Labels to Control MTO Dispositions - When this option is set to Yes, MTO releases will be 

combined on work orders rather than getting a work order for each release (including 
multiple customers/orders). All other allocation functions of MTO will remain the same, only 
bucketing is different. When printing labels, the Order # drop down will reflect the customer 

for that order on the label. This option can be set at the Manufacturing Type level, which will 
override the default setting in System Parameters->Purchase Order and Sales Order Setup 
tab. Choices in the drop down are System Default, Yes, and No. ‘System Default’ will look at 

the global setting. A selection of ‘Yes’ will enable the ‘Use SN Labels to Control MTO 
Dispositions’ functionality for the specific Manufacturing Type. If ‘No’ is selected the 
functionality will not apply to that particular Manufacturing type. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Logical_2D00_Work_2D00_Centers.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/Logical_2D00_Work_2D00_Centers.pdf
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➢ Auto Substitute BOM - When this setting is enabled, when attempting to add a work order to 

the first position (in EIQ or ShopData), the system will look to see if the BOM on the work 
order is already scheduled in the first position on a logical work center. If the same BOM is 

already scheduled/running on a logical work center, and the user is trying to add it to a 
different logical work center then a substitute BOM will be created before adding the work 
order. A security enabled warning message will appear: “Attempting to schedule this work 

order on a different logical work center than the currently running BOM. What do you want 
to do?" The warning message that surfaces will give the user the option to 'Create a 
substitute BOM' or 'Do not create substitute BOM'. There is also a “Do not show again” 
check box. Note: This option is visible on all MFG Types but will not affect anything unless 

the MFG Type also has 'Logical Work Center Support' enabled. 

➢ Plug Value - This is used for informational purposes only. 

➢ Disposition all Hard Allocated raw material when work order is marked "Prod Finished" - This option 

can be set at the Manufacturing Type level so that when materials are backflushed for a 
work order that has been marked 'Prod Finished' either by selecting 'Workorder xxx is 

finished' when performing a setup in RealTime™ or Scheduling, or when it is manually 
checked in the production report, all hard allocated materials will be removed from inventory 
instead of the calculated required quantity. For example, if the quantity hard allocated is 

1500 and the required quantity based on what was manufactured is 1250, the system would 
remove the 1500 when this is checked, if not checked it would remove 1250. If some 
required material was not hard allocated the system will calculate the material usage using 

the standard method, i.e. by evaluating total cycles and parts counted, etc. 

➢ The system will look at the Work Center/Manufacturing Cell that the work order actually ran 
on when verifying whether or not the options are checked. This also applies to Non-

RealTime Production Reporting by Shift (PRS). If a work center/Manufacturing Cell is 
selected that differs from the one the BOM has assigned, the Work Center/Manufacturing 
Cell in PRS will be used. 

There are three options that can be selected from the drop down list: Yes, No, and System Default.  

▪ Yes - When Yes is selected the option is enabled at the this level. 

▪ No - When no is selected the option is not enabled at this level and the system will not continue 
looking at the hierarchy. 

▪ System Default - By default it is set to 'System Default'. If system default is selected the system will 
evaluate the hierarchy.  

A mouse-over hint is available when hovering on the setting that will let the user know which level of 
hierarchy will be used for both options (Disposition all Hard Allocated... and Freeze Consumption...), and 
what the values are. For example, "All hard allocated materials will be consumed. Consumption beyond 
hard allocated will not be frozen. Hierarchy Level = System". 

The hierarchy for this option is: 

1 Work Center 

2 Manufacturing Cell 
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3 Manufacturing Type 

4 Production Reporting by Shift Parameter 
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Note: This feature is available for all MFG types except ASSY2, ASSY3, and COMPLEX. 

➢ Freeze consumption beyond hard allocated - This option will be available if the 'Disposition all 

Hard Allocated raw material when work order is marked "Prod Finished"' option is checked. 
If this option is enabled and 'Prod Finished' is checked for the work order, the system will 
not consume more material than what was hard allocated. 

Note: When dispositioning the item the system will show material/components that were not hard 
allocated to the WO and only freeze consumption of material/components that were hard allocated but 
have been brought to zero through Return to Inventory or consumption. 

General Tab for Assembly MFG Types (ASSY1, 2 and 3): 

➢ Process Certification – (This only applies to ASSY1) Select the desired process certification 

from the drop down list. The Certified tab in Assembly Process Maintenance will adjust 

depending on the selection made here. There are two choices: 

▪ Certified Jobs – (Default) - Users can specify job requirements for running the process. This will limit 
which employees can log into a specific process. Only those employees with an active certification 
level high enough for the specific job can log into the process. 

▪ Certified Employees – With this option selected individual employees will be certified on a process 
rather than a job. 

➢ No Supervisor required for Final Assembly – This option controls whether a supervisor is required 

to enter the Final Assembly in AssemblyData. 

Note: The ‘Process Certification’ and 'No Supervisor Required for Final Assembly' settings will be 
determined by the default predefined ASSY MFG type for any user defined MFG Types based on the ASSY 
type.  The reason for this is the potential to have the same process linked to multiple BOM's. 

➢ Dispo IN and OUT Locations – A disposition In and Out location can be entered here. Click on 

the ellipsis button and select a location from the pick list. The Mfg Type dispo designated 
locations will fit into the hierarchy after the Mfg Cell dispo designator locations for both IN 

and OUT locations. This option is also available on user defined MFG Types that are based 
on the ASSY Type. 

➢ Use Percent Complete Reporting - (For ASSY1 and ASSY2 MFG Types) - If this option is 

checked, when reporting labor for an ASSY1/ASSY2 work order/process, a percentage can 
be reported against a process instead of entering a quantity.  In Assembly Track and 

JobShop, the Progress bar in the Process Details will display the last percent complete that 
was reported.  Material attached to the process being reported on will not be backflushed 
until Final Assembly Reporting. 
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➢ Consume Raw Material by Process - If the 'Use Percent Complete Reporting' option is selected 

this option is available. If this option is unchecked, in Assembly Track-> Labor Reporting, 
the Report Consumed Materials tab will be hidden. Material will be backflushed upon Final 

Assembly.  If this option is checked, in Assembly Track-> Labor Reporting, the Report 
Consumed Materials tab will be visible to enter a value of components to be backflushed. 
Upon Final Assembly the system will not backflush material. 

➢ Backflush Each Process - (For ASSY3 only). If this option is checked, when clocking out of a 

process in AssemblyData or labor reporting in Assembly Track, the system will backflush the 
components.  When performing Final Assembly, it will not backflush the components. This 

allows users to be able to finite schedule a work order to an Assembly Line and still allow for 
backflushing at each process.  

Note: If this option is not checked, the Processing Time on the BOM must be calculated using the Process 
Throughput Map button. If it is not calculated the system will have no way to know when material(s) are 
required so it will assume it will end on the last day. 

➢ Launch Final Assembly Reporting on designated process - If this is checked users can designate a 

single process in the Assembly BOM that will launch the “Final Assembly Reporting” form. 
The Assembly BOM can only have one process designated as “Final Assembly Reporting”. 

➢ Use SN Labels to Control MTO Dispositions - When this option is set to Yes, MTO releases will be 

combined on work orders rather than getting a work order for each release (including 
multiple customers/orders). All other allocation functions of MTO will remain the same, only 
bucketing is different. When printing labels, the Order # drop down will reflect the customer 

for that order on the label. This option can be set at the Manufacturing Type level, which will 
override the default setting in System Parameters->Purchase Order and Sales Order Setup 
tab. Choices in the drop down are System Default, Yes, and No. ‘System Default’ will look at 

the global setting. A selection of ‘Yes’ will enable the ‘Use SN Labels to Control MTO 
Dispositions’ functionality for the specific Manufacturing Type. If ‘No’ is selected the 
functionality will not apply to that particular Manufacturing type. 

➢ Auto Substitute BOM - When this setting is enabled, when attempting to add a work order to 

the first position (in EIQ or ShopData), the system will look to see if the BOM on the work 
order is already scheduled in the first position on a logical work center. If the same BOM is 

already scheduled/running on a logical work center, and the user is trying to add it to a 
different logical work center then a substitute BOM will be created before adding the work 
order. A security enabled warning message will appear: “Attempting to schedule this work 

order on a different logical work center than the currently running BOM. What do you want 
to do?" The warning message that surfaces will give the user the option to 'Create a 
substitute BOM' or 'Do not create substitute BOM'. There is also a “Do not show again” 
check box. Note: This option is visible on all MFG Types but will not affect anything unless 

the MFG Type also has 'Logical Work Center Support' enabled. 

➢ Plug Value - This is used for informational purposes only. 

For more information on the ASSY MFG Types please refer to the ASSY Manufacturing documentation. 
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File Menu: 

Alter Lbs/K Calculation - This option is only available to the Injection and Diecast MFG Types, and for 
Custom MFG Types that default to Injection and Diecast.  Injection and Diecast MFG Types can have a 
different percent. There can only be one % value for Injection and custom MFG Types like Injection, and 
the same is true for Diecast and MFG types like Diecast. 

From the File menu select the ‘Alter Lbs/K Calculation’ option. A screen will appear for users to enter in a 
different percent of the runner and sprue to be used when calculating the Lbs/K for BOM’s associated to 
the selected manufacturing type. This defaults to 0.   

 

After entering a new percent the user can check the ‘Recalculate all BOM’ box to have the system 
recalculate the Lbs/K for all BOM’s associated to the selected manufacturing type.  

When users do not check the Recalculate BOM box, what is calculated depends on where the changes 
are made: 

▪ When on a Diecast BOM and the user goes to Configure->Mfg Types, selects Diecast and changes the 
% but does not check Recalculate BOM. When they exit the form only the BOM they were on will 
recalculate. 

▪ When on an Injection BOM and the user goes to Configure->Mfg Types, selects Diecast and changes 
the % but does not check Recalculate BOM.  When they exit the form no BOMs are recalculated. 

▪ When on a Diecast BOM and the user accesses Mfg Types from the Launcher File menu or from Lists 
in System Parameters, when they change the % and do not check Recalculate BOM, when they exit 
Mfg Types and refresh the BOM form that BOM is recalculated but other Diecast BOMs are not. 

▪ If the BOM form is not open and the user accesses Mfg Types from the Launcher File menu or from 
Lists in System Parameters, when they change the % and do not check Recalculate BOM, when they 
exit Mfg Types, no BOMs are updated. 

Example Calculation: 

The Alter Lbs/K value only applies when AA - AB < Cavity * Part Weight 

AA is the Shot Weight, taking into account runner/sprue and scrap = (Cavity * Cavity Weight + 
Runner/Sprue) / Yield 

AB is the Shot Weight * regrind percentage = AA * (Regrind / 100) 
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Example:  Cavity * part weight is 12.05 and Regrind is 5% 

AA = (1 * 12.05 + 12.05)/ .95 

AA =  25.3684 

AB = AA * (Regrind / 100) 

AB = 25.3684 * .05 

AB = 1.26842 

AA - AB = 24.1 

24.1  is not less than 12.05,  so with these numbers the Alter Lbs/K value is not used 

If Regrind is 75%: 

AB = 25.3684 * .75 

AB = 19.0263 

AA - AB = 6.3421 

6.3421 is less than 12.05,  so with these numbers the Alter Lbs/K value is used. 

Please see Calculations for LBS/K Cycles for more information. 

User Defined Conversion Factor 

Each MFG Type has default values for the basic calculations such as cycle time and shots per hour. This 
function allows the user to override the defaults and create user defined factors for a specific MFG Type. 

Select the  speed button to open the form to input the conversion information for the highlighted 
MFG Type. The form will be empty when first opened. 
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Select the speed button on this form to add all of the fields available for creating user defined 
conversions, or select the arrow down button next to the speed button to choose a single item. 

For each field selected the Default Caption will fill in automatically. 

 

The user can change the caption and/or the unit of measure: 

▪ UD UOM - To change the unit of measure, double-click in the UD UOM field and the following Define 
UOM form will appear: 

 

Choose the desired unit of measure (Second, Minute, Hour, or Day) from the drop down list and select 
OK. The user defined caption will fill in automatically with the selected UOM but can be overridden. The 
Factor field is based on the UOM chosen and cannot be edited. 

▪ UD Caption - To change the caption that appears on the BOM form for this MFG Type enter the 
information in the UD Caption field. 
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Labor Rates 

Labor rates can be setup in several areas within EIQ, each with a slightly different focus. For example, the 
quote module contains labor rates for quoting, default values are part of the Manufacturing Type 
system, and individual rates can be assigned to the BOM or Manufacturing Cell. 

Manufacturing Types 

Each type (Injection, Outsource, Generic, etc.) maintains a default labor rate. This hourly figure is used by 
EnterpriseIQ to calculate labor based on how the part is made. This value can be over written within 
each BOM. 

From within any BOM, click the Configure menu option and select Mfg Type. Enter an appropriate hourly 
value in the Default Labor Rate field. 

Manufacturing Cells 

If manufacturing cells are being used, labor rates may be assigned to the cells which will override the 
default rate set in the Manufacturing Type (see Manufacturing Cells below). 

Individual Rates per BOM 

From within the Manufacturing Configuration screen: 

➢ Click on Options|Misc. Parameters. 

➢ From within the Misc. Parameters screen, click on the tab entitled “Labor Rate.” 

➢ If wishing to override the default Labor Rate, enter in a different amount here and press 

[OK] to accept. The labor rate entered here effects only the current BOM. 

Employee Levels 

The labor rate used for specific BOM’s can also be overridden by setting up Employee Levels and then 
attaching the specific levels to the BOM in the labor field on the General BOM Info tab. 

Employee Levels are set up in Sys Setup/System Parameters/Lists/Employee Levels. An unlimited number 
of employee levels may be set up from this form. 
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A Default level code is automatically created. To create additional employee levels click on the ADD (+) 

button and enter in the code, description, and labor rate. 

Labor Type - This field is used to establish the type of labor the employee level is. The labor type can be 
Production or Setup. The user has the choice to have the setup labor broken out on the standard cost for 
a manufactured item. To separate the setup labor select the 'Break out Labor Costs including Setup' 
option in System Setup->System Parameters->Inventory Setup tab and create Employee Levels as Setup 
types. Without both these settings, setup labor will be calculated like normal labor. 

When the standard cost is calculated the system will check to see if this option is on and if so will break 
out the labor costs to the cost elements attached to any employee levels on the BOM. For “Setup” types, 
the system will look at the number of setup hours on the BOM X the number of operators for that type X 
the rate for the level / the standard run qty. 

Labor Cost Element - Each employee level can have a specific cost element associated with for use in 
standard costing. 

Once this list is created the user may attach specific employee levels to BOM’s. Multiple levels may be 
attached to a BOM. This allows the user to control various labor rates for each BOM. 

Labor Rate Hierarchy 

Below describes the hierarchy of how the system will determine the standard labor rate: 

1 First the system will use the employee levels set up for each BOM if other than the default is used. If 
the Default employee level is used the system will look at the following for the labor rate: 

2 BOM/Options/Misc Parameters/Labor tab. 

3 Mfg Cell. 

4 Mfg Type. 
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For ASSY, the Cost Element hierarchy for labor when reporting Process WIP as follows: 

1 Employee Maintenance > Misc. tab 

2 Assembly Process Maintenance > Standard Cost tab 

3 MFG Type > Labor/Overhead tab 

4 "Labor" (text) 
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Manufacturing Cells 

Manufacturing Cells 

Cells allow a logical grouping of work centers. A manufacturing cell may consist of only one work center 
or several like work centers. For example, the user may want to separate the smaller work centers from 
the larger work centers. EnterpriseIQ also supports a filter option, allowing the display of work centers 
based on certain criteria. 

NOTE: Make sure to set up all cells in advance before scheduling or trying to access cells from within 
RealTimeTM. The user may create as many cells as needed, including multiple RealTimeTM cells. However, 
any non-RealTimeTM machines must be placed in a separate cell. 

Notes on Using Cells 

The Manufacturing Cell was designed as a separate area to do scheduling and production reporting. A 
company with manufacturing being performed in two separate buildings might consider using cells to 
schedule jobs at each building and report on production separately. 

Once this function has been set up in the system, the user can create manufacturing standards that are 
used exclusively by a particular cell or shared by all cells. The user can then schedule these standards to 
run on work centers that are numbered differently for each cell and report the production being made 
by each. 

Setting Up Cells 

To setup Cells, from within the Work Center menu: 

➢ Select Options from the menu. 

➢ Select View MFG Cells. The following screen will be displayed: 
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➢ To add MFG Cells click on the ADD [+] function key located on the Navigator bar. Enter a cell 

designation, such as 1 or a location. Once a MFG Cell has been input, it CANNOT be edited. 
(The Description and other information can be edited but not the MFG Cell name). 

➢ Input a description of the cell. Press [Tab] to go onto the next field. 

➢ Click once on this field and click on the arrow down key to select a MFG Type from the list. 
Two different MFG types cannot be in the same MFG cell. 

➢ EPlant Name - This is the EPlant associated to the MFG Cell. 

➢ Division/Warehouse - If using the Division/Warehouse functionality, select the appropriate 
Division/Warehouse to be associated with the manufacturing cell.  (Please see the 

Warehouse/Division https://my.iqms.com/cfs-
file.ashx/__key/Technote/Warehouse_2D00_and_2D00_Divisions.pdf Technote 
for more information). 

➢ Additional Cell Information 

Production 
Reporting Method 

A production reporting method can be selected for individual Manufacturing Cells. The 
options are: 

▪ Production Report by Shift (PRS) - This is the default method (standard production 
reporting per shift). When a new cell is created it will default to this setting. 

▪ Production Report by Labor/Shift (PRLS) - With this option selected, the system will create a 
row for all employees logged into Time and Attendance, into a 'WC' task, with the number 
of parts floor dispositioned by them. Basically, if more than a single employee has worked 
on the work center / work order during the shift, the system will add a new line for the 
second, third, etc employees.  The good parts for each labor (Dayprod) row is the number 
of parts that the employee has floor dispositioned. 

▪ Production Report by Work Order (PRW) - If this is selected the system will suppress 
creating a production report for that Cell and production reporting must be done from the 
PRW module. Note: Finished work orders (RTServer counted down Parts to Go to zero) are 
not deleted when they are removed from first position if they are running in a 
Manufacturing Cell that is marked as Production Reporting by Work Order (PRW). 

▪ Production Reporting through Task Clock (PRTC) - Available for cells associated with 
Generic and User Defined cells based on Generic Mfg types, PRTC allows administrators to 
set lower and upper thresholds based on a percentage of how many good parts are being 
put into inventory versus the BOM Net Cycles/Hour. For example, if cycle time is 8 hours on 
the BOM and 1 part is expected within the 8 hours, labor is posted automatically if the user 
clocks in for 8 hours and production reports 1 good part within that time. If the same user 
does not report 1 good part within 8 hours, the labor is not posted since production does 
not fall within the set threshold. The Task Clock Group Reviewer function, set under the 
Misc tab in Employee Maintenance, grants individual employees the rights to review and 
post unposted Task Clock entries at the end of a work order to ensure all labor and 
overhead is posted against it when they clock out. The Group Reviewer function can be set 
for the entire manufacturing cell by checking the 'Labor posted from Time & Attendance' 
setting to expose the 'Enable Group Review' option, and checking the 'Enable Group 
Review option.  

https://my.iqms.com/cfs-file.ashx/__key/Technote/Warehouse_2D00_and_2D00_Divisions.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/Warehouse_2D00_and_2D00_Divisions.pdf
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Include posted labor 
in threshold 

This check box is available for generic manufacturing types when the 'Production 
Reporting through Task Clock' option is selected. When checked, posted labor is 
included in threshold calculations.  

Actual Cost This controls at what point the system performs the actual cost calculations when reporting 
by shift (PRS) or by labor/shift (PRLS). This option will be grayed and cannot be used with 
the PRW option. 

▪ Calculate Actual Cost 'By Shift' - This is the default method. Actual costs are calculated 
during production reporting. 

▪ Calculate Actual Cost 'By Work Order Reconciliation' - With this option selected the actual 
cost will not be calculated until they are reconciled for the work order on the Process Cost-
>Reconcile WO Act Cost tab. When the WO is removed from the first position in scheduling, 
HIST_ILLUM_RT.ACTUAL_END_TIME will be populated, which will trigger 
HIST_ILLUM_PART.RECONCILE_WO to ‘Y’.  In Process Cost – Reconcile WO Act Cost, the 
work order will be available to reconcile the cost.  The From field was when the work 
order was setup.  The To field is today's date.  These dates will be used to query 
TRANSLOG. A button to 'Reconcile Cost' will be available once an Average Actual Cost and 
Total Trans Quantity are populated.  Once cost is reconciled, FGMULTI actual cost will be 
populated/updated and the work order will be removed from WO reconciliation.  Please 
note that PIT transactions should not be posted prior to WO reconciliation.  Otherwise, 
standard cost may be used instead of actual cost. 
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Disposition 
Parameters 

A Disposition In and Out location can be set at the Manufacturing Cell level. When 
populated the system will look to see if the cell has a disposition location when determining 
the location to disposition product into or out of. Select the ellipsis button in the field and 
select the location from the pick list. 

The hierarchy is: 

 For Non-ASSY1/ASSY2/ASSY3 MFG Types the Disposition Hierarchy is: 

1 Hard Allocated to the work order 

2 Mfg # default designator 

3 Default Designator 

4 Designated Work Center location 

5 Mfg Cell Dispo locations 

6 FIFO 

7 Temporary 

For ASSY1/ASSY2/ASSY3 MFG Types the Disposition Hierarchy is: 

1 Hard allocated to the work order 

2 Mfg # default designator 

3 Default designator 

4 Designated work center location (if the process IS scheduled in Finite Scheduling) 

5 Designated work center location (if the process IS NOT scheduled in Finite 
Scheduling, but IS scheduled on the Dispatch List) 

6 MFG Cell Dispo locations 

7 MFG Type Dispo locations 

8 FIFO 

9 Temporary 
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Disposition all Hard 
Allocated raw 
material when work 
order is marked 
"Prod Finished" 

This option can be set at the Manufacturing Cell level so that when materials are 
backflushed for a work order that has been marked 'Prod Finished' either by selecting 
'Workorder xxx is finished' when performing a setup in RealTime™ or Scheduling, or when it 
is manually checked in the production report, all hard allocated materials will be removed 
from inventory instead of the calculated required quantity. For example, if the quantity hard 
allocated is 1500 and the required quantity based on what was manufactured is 1250, the 
system would remove the 1500 when this is checked, if not checked it would remove 1250. 

If some required material was not hard allocated the system will calculate the material 
usage using the standard method, i.e. by evaluating total cycles and parts counted, etc. 

The system will look at the Work Center/Manufacturing Cell that the work order actually 
ran on when verifying whether or not the options are checked. This also applies to Non-
RealTime Production Reporting by Shift (PRS). If a work center/Manufacturing Cell is 
selected that differs from the one the BOM has assigned, the Work Center/Manufacturing 
Cell in PRS will be used. 

There are three options that can be selected from the drop down list: Yes, No, and System 
Default.  

▪ Yes - When Yes is selected the option is enabled at the this level. 

▪ No - When no is selected the option is not enabled at this level and the system will not 
continue looking at the hierarchy. 

▪ System Default - By default it is set to 'System Default'. If system default is selected the 
system will evaluate the hierarchy.  

A mouse-over hint is available when hovering on the setting that will let the user know 
which level of hierarchy will be used for both options (Disposition all Hard Allocated... and 
Freeze Consumption...), and what the values are. For example, "All hard allocated materials 
will be consumed. Consumption beyond hard allocated will not be frozen. Hierarchy Level = 
System".  

The hierarchy for this option is: 

1 Work Center 

2 Manufacturing Cell 

3 Manufacturing Type 

4 Production Reporting by Shift Parameter 

Note: This feature is available for all MFG types except ASSY2, ASSY3, and 
COMPLEX. 

Freeze consumption 
beyond hard 
allocated 

This option will be available if the 'Disposition all Hard Allocated raw material when work 
order is marked "Prod Finished"' option is checked. If this option is enabled and 'Prod 
Finished' is checked for the work order, the system will not consume more material than 
what was hard allocated. 

Note: When dispositioning the item the system will show material/components 
that were not hard allocated to the WO and only freeze consumption of 
material/components that were hard allocated but have been brought to zero 
through Return to Inventory or consumption. 
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Labor Rate A standard labor rate can be attached to individual Manufacturing cells. If the ‘Default’ 
employee level is selected for a BOM the labor rate associated with the cell will be used if 
there is one. If not, the system will use the labor rate associated with the Manufacturing 
type. 

Rates can be set for Current, Future, Budget, and Forecast. If these costs are populated, the 
system will use these instead of the current cost for calculating the applicable cost such as 
Future Cost.The same cost elements assigned to the center type will be used for these 
calculations. 

Rejects Component rejection location is mandatory - Check this box to require users to select a 
location/lot for rejected components from ShopData Rejects, RT Production Monitoring 
Rejects, Assembly Track Labor Reporting, AssemblyData Labor Reporting, and RT Station 
Rejects. If checked and a location/lot is not selected an error will appear stating: 'A 
component reject location is mandatory. Please select a location'. 

This option is unchecked by default. If unchecked users can optionally select a location/lot 
for rejected components, but it will not be required. 

 
When finished adding the cell information, click on the SAVE function key (the check mark) located on 
the Navigator bar to save this information. 

Note: 

If you plan to setup cells and are currently using the scheduling and production reporting modules and 
RT Server, you will need to follow the above steps plus what is listed below to avoid production reporting 
problems. 

You will need to run the Setup routine for all jobs currently running in the first position. 

1 Go to the production schedule module 

2 Schedule downtime in position one for all work centers hooked up to RealTime 

3 The job currently running will move to position 2 on the press 

4 Select this job and drag and drop to position 1 again 

5 Delete the scheduled downtime 

6 Repeat for all work centers hooked up to RealTime 

Deleting Cells 

To DELETE a cell: 

➢ Highlight the cell to delete and choose the Delete [-] function key located on the Navigator 

bar. A prompt will appear asking for confirmation of this action. 

➢ Select [OK] to delete, or [Cancel] to exit. 

Note: Any work center attached to that cell will now have a null or empty cell name and will need to be 
reassigned. 

1  
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Work Centers 

Before a schedule can be created, valid work centers must be defined. The IQMS RealTimeTM system and 
schedule modules are based on Work Orders loaded onto the work centers. 

What is a Work Center? 

Work centers are used to describe the type of machinery used to build the parts. Examples of work 
centers may include injection or blow molding machines, extrusion machines, die casting machines, pad 
printers, heat stamping centers, and assembly operations. 

Work Centers and Cells 

Work centers can be included in manufacturing cells. Cells, described in detail earlier in this section, 
allow the grouping of work centers. Cells are often used to separate certain machines by size or process, 
which allows EnterpriseIQ to schedule and report on production by these groups. If cells are going to be 
used, be sure to set them up in advance. 

To access the Work Center module, complete the following steps. 

➢ Select the Work Center module from the EIQ Launcher Bar. 

➢ From the pick list that will appear, click on “New” located in the bottom right hand corner of 
the screen. Select the MFG Type or MFG Cell form the selection criteria form, then the work 
center form for the selected MFG Type/Cell will appear. 

Entering Work Centers 
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EnterpriseIQ supports the entry of unlimited number of work centers into the system. Enter in the 
information as outlined below in the Work Center Field Listing. 

Work Center Description Information 

Work Center # Enter a unique identification number. This is an alphanumeric field that may hold up to 25 
characters. 

To enter a list in numerical order, the user may need to “pad” the first machines with a 0. For 
example, enter work center one as “1” and work center eleven as “11”, work center 11 will 
display on the pick list just after work center 1. The user should enter work center one as “01”, 
work center two as “02” and so on for them to show in numerical order. 

If you are using EnterpriseIQ’s Maintenance, Repair and Overhaul module this number will be 
the equipment number in MRO as well. 
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Description Used for further description of the work center. This field is displayed on the work center 
picklist. It should be used to fully describe the work center. This field is mandatory, if it is not 
populated a warning will appear, 'Field, Description, must have a value'. 

This field can also be used to designate the machine number should the user ever choose to 
renumber work centers. If work centers are renumbered the actual work center number should 
not be changed due to the effect on the historical data. However, the user can use the 
description field to include the work center number which can be changed if necessary without 
affecting the historical data. Many screens throughout EnterpriseIQ such as Scheduling, 
RealTimeTM, and ShopData can be sorted using the description field. 

Inactive If this box is checked the work center will be hidden from pick lists, Finite Scheduling, and the RT 
Monitor. 

Center Type The Type is used to “group” similar work centers, usually by size or other similar measurement of 
throughput. This mechanism allows the system to understand that you have one or many 
machines that share common characteristics. 

Select the Type field from the pick list. This list comes from the Master Center Type table and 
includes center types associated to the EPlant the user is logged into, or ones with no EPlant 
assigned. If a user associates a type without an EPlant to a work center while logged into an 
EPlant, the system will add a work center type+eplant record in the database. See Master Center 
Types for details on creating and editing center types. A new center type can be added from the 
picklist by selecting the New button, however, this will only allow the user to add the center type 
and not the cost information. The cost information can be added at a later time in the Master 
Center Types form. 

Outsource: If setting up this work center as Outsource (for items not being processed in-house), 
the user must select a Manufacturing Type from the arrow down list in that field first, and then 
go back to the Type field and click on the pick list to associate a vendor with this work center. 

SFOAM: This field is called Platen Type. 

If the user attempts to modify the Center Type on the work center, a warning will appear stating 
how many BOMs or Processes are affected.  

 

A check box is available to update all affected BOMs and Processes. If this is checked the system 
will change the center type on the affected BOMs and Processes. If it is not checked the system 
will just change the center type on the work center without changing the affected BOMs and 
Processes. (Security can be placed on this check box). If Abort is selected no changes are made to 
the work center's center type. 

Capacity Informational Only.  It is a numeric field only. May be up to 10 digits in length. This information 
will display at the bottom of the finite schedule. 

For example: For injection type work centers this usually designates the barrel size in ounces or 
can be used to designate shot weight. 
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EPlant Name Used with the Enterprise module to define the EPlant associated to the work center. 

Snap to Last 
Job 

Selecting the function Snap to Last Job tells the system not to place any idle time between the 
end of one work order and the start of the next work order. This option can be set up per work 
center by selecting a value from the drop down list. Select Yes to always have the system Snap 
To Last Job. Select No to not activate this feature. Select System Default to use the setting in the 
Scheduling module. If this field is left blank it will use the System Default. 

Plug Value This is used for informational purposes only. 

Manufacturing 
Cell 

Use this field to attach a work center to a designated cell. Click on the arrow down near this 
field, and choose the appropriate cell from the pick list. 

Note: Signaled and non-signaled work centers should not be in the same manufacturing cell. This 
should not be done since the shift change is done by cell, and if the work center is not signaled 
the system will look for floor dispositions, and if there are signaled and non-signaled in the same 
cell it will cause some work centers to not to be a part of the production report. 

Manufacturing 
Type 

Manufacturing type describes the work center as belonging to a particular “type” of 
manufacturing (i.e. Injection, Generic, Extrusion, Outsource, etc.). 

Center Rate Enter the machine rate. This field is used only for quoting. It will populate the Center Rate field in 
Engineering Quotes. 

Fixed Machine 
Rate 

Enter the Fixed machine rate. This field is used only for quoting. It will populate the Fixed 
Machine Rate field in Engineering Quotes. 

Start-up Cycles This is the number of shots required to “dial in” a tool. It is used to determine the pounds of 
material used for quoting purposes. 

Setup Hours The number of hours required to set up for the process for this work center. This information is 
used for quoting purposes. 

Time Fence A work center may store a Time Fence, used with the Auto Loading feature of the scheduling 
module (the system also maintains a Global Time Fence value). This value, stored in days, will 
hold the position of any job(s) scheduled on this work center for the number of days listed here. 
During Auto Loading, EnterpriseIQ will not move or reschedule jobs within this time fence. 

Exclude from 
Auto Load 

If this option is checked the system will exclude this work center from the auto load process in 
the finite schedule. 

Exclude from 
MRO 

If this box is checked the system will not add the work center to Maintenance, Repair and 
Overhaul. A message will appear stating, "This work center will not be associated with MRO - are 
you sure you want to continue?" The MRO and Association Manager options will be grayed out 
(Options menu). Security can be placed on the check box (not the message).  

If the box is unchecked after being checked, the system will create a record in MRO. The user will 
see this message, with a Yes and No button, "About to associate this work center with MRO - are 
you sure you want to continue?" 

If a user attempts to check this box for a work center that has tasks they will receive an "Master 
has detail records. Cannot delete or modify" error. 

Note: The default security roles have all been set with ‘Enabled’ unchecked. This is to help 
prevent possible deletion of the entire MRO record by accident after updating security roles. 



Initial Data Entry Page 38 of 91 

 

Center Cost 

Center Cost 

(Fixed and 
Variable 
Overhead) 

The center cost is the variable and fixed costs associated to the work center. This information is 
used in standard cost calculations.  

If the 'Use Master Center Type Cost Settings' option is checked this information will come from 
the Work Center Type table. It cannot be edited from the work center module. Changes can be 
made to costs from the center type table for a specific center type and be applied to all work 
centers with that type. See Master Center Types for more information. 

If the 'Use Master Center Type Cost Settings' option is not checked users can change the 
information from this section of the module. Add a cost element by clicking on the [+] in the 
Center Cost section of the form and select the element from the arrow down list. Enter the 
variable and fixed costs associated to the work center. More than one cost element can be 
assigned to a work center. The multiple cost elements will total to the Center Cost which is what 
the system will use in calculating the Overhead standard cost for manufactured items. 

The default work center variable cost can be manually overridden for each item in Inventory. Go 
to Mfg tab - Inventory - STD Costing tab. From the STD Costing Tab, select the Center Cost field 
and enter the work center cost to be used for this particular item. This will be the variable center 
cost used to calculate the standard cost of the item.  

Note: When a user checks the Work Center ‘Use Master Center Type Cost Settings’ 
checkbox. ‘All Standard Costs for Manufactured Items that use this Center Type must 
be recalculated and rolled to avoid variances when processing Post Inventory 
Transactions. See Help Files for more information. Do you want to continue?' Security 
can be placed on the Yes button.  

See Standard Costs for Manufactured Items for information on recalculating and rolling costs. 

RealTimeTM Information 

Connected to 
RT Server 

Check this box if the work center is monitored by the RealTimeTM server. See Assigning the 
Work Center to RealTime information. 

If checking 'Connected to RT Server' causes the user to exceed their RT Licenses, a warning is 
surfaced 'You are about to exceed your RT License quantity, do you wish to proceed?' When 
selecting No, 'Connected to RT Server' will be unchecked. If the user selects Yes, the edit will 
be posted and the count and licensed fields will turn red on the RealTime Addresses Board. 

RT Server is not 
signaled 

Check this box if the work center is not connected to the RT server. NOTE: A machine may 
have both boxes checked, it may be monitored by RT but not actually connected. The 
advantage to this is a line item will be created automatically for production reporting 
purposes, but no actual cycle data will be supplied. This does require an RT address. 

Note: If no work center (signaled or non-signaled) in the system makes a cycle through the 
entire shift then no production reports will be created. If any work center  does receive a 
cycle, then a production report will be created for the MFG Cells. 

Note: When this is checked, the Total Cycles field on the Production report will automatically 
populate with the total Floor Dispositions during that shift. 
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Floor Backflush This feature is used by IQRF or WMS for work centers that do not signal RealTimeTM. If 
checked, when items are scanned into inventory from the work center, the backflushing of the 
raw materials will occur automatically. If not checked, the materials used to produce the parts 
will not be removed except through production reporting. 

With an RT Address assigned to a non-signaled work center, the production report shows floor 
disposition records are automatically completed. Material details are not included in the 
production report, but are shown within the transaction log. Users can manually add 'Non-RT' 
records to disposition additional Good Parts through Production Reporting.  

Floor Actual 
Material Usage 

With this option checked users can enter the actual amount of primary material used during 
Floor Dispositions in Shop Data. This will replace the calculated material usage in production 
reporting. 

Note: This should only be checked on Work Centers for MFG Types that use primary 
materials. 
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Log Cycle 
Times 

If this option is checked the system will log cycle times for the work center. This is designed for 
trouble shooting cycle times and should not be set for all work centers as it will fill up a lot of 
drive space. This information can be viewed from RealTimeTM (File->View Cycles Log) and 
Production Reporting (Right Click->View Archived Cycles). 

 

This feature is not designed as a cycle counter. The production report will contain the correct 
cycles. RT Cycle Log only picks up information when the machine is in run mode, where the 
production report counts every cycle. 

Note: The table that stores the cycles will grow quite large and it may be necessary to 
use IQPurge to delete old information. The following SQL block will delete records 
older than 90 days. (Please see the IQPurge https://my.iqms.com/cfs-
file.ashx/__key/Technote/IQPurge.pdf TechNote for more information. 

declare 

  v_days  number:= 90; 

  I       number; 

begin 

  loop 

    I:= 0; 

    for v in (select id from illm_cycle_hist where timestamp <= sysdate - v_days order by id) 

    loop 

      delete from illm_cycle_hist where id = v.id; 

      I:= I + 1; 

      commit; 

      exit when I > 300; 

    end loop; 

    exit when I = 0; 

  end loop; 

end; 

https://my.iqms.com/cfs-file.ashx/__key/Technote/IQPurge.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/IQPurge.pdf


Initial Data Entry Page 41 of 91 

 

/ 



Initial Data Entry Page 42 of 91 

 

Connected to 
Wireless 
Lightstick 

Optionally users can connect a wireless status indicator to a work center which includes four 
lights on a stick. 

▪ Green - Running within standard cycle threshold 

▪ Blue - Running faster than standard cycle threshold 

▪ Red (Solid) - Running slower than standard cycle threshold 

▪ Red (Flashing) - Overrunning of job is occurring 

▪ Yellow - Work center is down 

If this option is checked RTServer will send a signal to the wireless indicator (mote) based on 
the LightStick address. 

For additional information on LightSticks please see the RealTime LightstickTM https://my.iqms.com/cfs-

file.ashx/__key/Technote/RealTime_2D00_LightStick.pdf TechNote. 

LightStick 
Address 

If the Connected to Wireless LightStick is checked this field will become visible. Enter the 
address associated to the LightStick. 

For Wireless RealTimeTM, the LightStick address must match the work center address. 

For Wired RealTimeTM, this address represents the LightStick address. 

Use Dedicated 
Output 

The Use Dedicated Output is for use when a wired RT System is used in conjunction with a 
wireless LightStick system that requires multiple gateways. The reason for this is that a wired 
system can potentially span multiple rooms or buildings which a single wireless gateway 
cannot cover.  When a single wired RT Box does span multiple wireless gateways, then it 
must be configured this way. 

RT Server Prefix The RT server prefix (i.e. SND) - used only if multiple RT boxes at the same site. 

Center RealTime 
Address 

The RT address assigned to the work center. This is populated by EIQ when an address is 
assigned.  

Center Scrap 
Address 

An additional RT address assigned to the work center to collect scrap data. 

Monitor Service 
Group 

This field is used in RealTime Process Monitoring. Service Groups can be created (Work Center 
Options menu) and then assigned to work centers. Then from the RealTime Process 
Monitoring Service users can set a specific Service Group to be monitored. If the service group 
is not set in the RealTime Process Monitoring Service, the service will operate on all work 
centers that do not belong to a service group. For more information please see the RT Process 
Monitoring TechNote https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-
Process-Monitoring.pdf. 

RT Label Group This field is used in the RT Labels Monitor module. RT Label Groups can be created (Work 
Center Options menu) and then assigned to work centers. From RT Labels Monitor a specific 
group can be selected to be monitored. For more information please see the RT Labels 
Monitor https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Label-
Monitor.pdf TechNote. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2D00_LightStick.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2D00_LightStick.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Process-Monitoring.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Process-Monitoring.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Label-Monitor.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Label-Monitor.pdf
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Note: When creating a new work center the system determines available hours to be 24/7 instead of 
what is designated in the Shop Calendar.  The system can only recognize the specific shop calendar for 
the new work center for capacity planning purposes after the Set Default Calendar function is run, the 
schedule is updated, and RTServer must be stopped/re-started as well. 

Note: When a user creates a User Defined Form field and grants security to that UDF field, if the UDF field 
is deleted the security to the field is removed. If the UDF field is re-added with the same name, security 
will need to be reestablished for users. 
 



Initial Data Entry Page 44 of 91 

 

Master Center Types 

The Master Center Type table lists all of the work center types and their costs. The center types are 
associated to work centers and processes. Standard Costing will look up the work center type from the 
BOM and check if there is a work center of this type that has the 'Use master center type cost setting' 
checked, if there is one the system will use the Master Center Type Current variable and fixed costs. If 
the system does not find this work center type has any work centers with the 'Use master center type 
cost' checked, the system will use the costs from the actual work center of this type instead of the 
Master Center table.  If the variable center cost is manually overridden for the item in Inventory 
(Inventory - STD Costing tab - Center Cost field), the system will use that value instead.  

To access this table select the speed button in the Center Cost section of the work center module . 

The following form will appear. (Note: If work centers already exist this table will be populated with all of 
the center types currently associated to existing work centers and processes).  
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➢ To enter a new center type select the insert record button and enter the Center Type in the 

field.  The Center Type table can contain only one Center Type + EPlant combination, the 
EPlant can be null and used across EPlants. In the case of injection molding machines, the 
center type is normally the tonnage rating. In the case of an extrusion machine, it is 

normally the line size. In the case of Generic Work Centers (pad printers, die cutters, 
blenders, etc.), use wording that describes the capacity of the center. This may be a size or 
a certain model number. EnterpriseIQ needs this information for costing and so that a 

capacity can be derived. By assigning a center type to the work center, the system can 
determine where it needs to be scheduled, and if capacity is available. The Type is also 
associated to the work order which assists scheduling by telling the system where the job 

can be run. 

➢ Select the lower insert record button to assign cost elements. Select the cost element from 
the pick list. If these columns are populated the system will use these overhead cost 

elements instead of going to the Manufacturing Type table to get the overhead cost 
elements. This affects both Standard Cost calculations and writing the Overhead information 
to Translog during Dispositions, Backflushing, etc.  

Note: Variances in overhead will occur if the work center type associated to the BOM is different than the 
one it ran in. For example, if the BOM is supposed to run on a 50 ton work center but it was put in a 75 
ton work center and those work center types have a different overhead cost, a variance for the 
difference in overhead per hour will occur.  If the name of the cost element associated to the item is 
different than the one associated to the work center type the system will put the full overhead amount 
as a variance. In order to avoid the entire amount of Overhead going to a variance, make sure the cost 
element on the inventory item when the costs are rolled matches the cost element on the 
Manufacturing Type of the BOM for that item. This will require associating the same Cost Element on the 
Manufacturing Type as the one associated to the Master Center Type. 

➢ Enter the Variable and/or Fixed Cost that applies to the cost element for the center type. 
Multiple Cost Elements can be associated to the center type. The costs will populate in the 

fields in the top section of this form. When costs are rolled, the variable overhead will be 
summarized and the cost will use the first variable overhead entered. The fixed overhead 
will be summarized and the cost will use the first fixed overhead entered. 

➢ Once a new entry is made in this table, or if changes are made to costs on an existing 
center type the line will be highlighted in red. This indicates that there has been changes to 
the costs and they have not been applied to the work centers. Select the 'Apply Pending' 

button and 'Yes' on the confirm message box to update all of the Work Centers of the same 
Center Type with the new costs. The work center's costs will only be updated if their 'Use 
Master Center Type Cost Settings' boxes are checked.  
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Additional Costs 

Values can be entered for Future, Budget, and Forecast variable and fixed costs. If these costs are 
populated, the system will use these instead of the current cost for calculating the applicable cost such 
as Future Cost.  If costs are not populated for the various costs the system will use the current cost. The 
same cost elements assigned to the center type will be used for these calculations. 

To enter a cost type the value in the grid in the desired cost field. 
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Assigning the Work Center to RealTime 

In the bottom portion of the Work Center screen, the user can indicate whether or not this work center 
is to be assigned to the RealTimeTM monitoring system by selecting the ‘Connected to RT Server’ box. 
Once this box is checked the user will need to assign a RT Address to the work center. By assigning the 
address, the work center is added to ILLUM_RT. 

Note: If not using the RealTime™ Monitoring System, this option will not be available. If this is the first 
time at attempting to connect the work center to RealTime™, the fields in this area will be blank. 

Note: If checking 'Connected to RT Server' causes the user to exceed their RT Licenses, a warning is 
surfaced 'You are about to exceed your RT License quantity, do you wish to proceed?' When selecting 
No, 'Connected to RT Server' will be unchecked. If the user selects Yes, the edit will be posted and the 
count and licensed fields will turn red on the RealTime Addresses Board. 

ASSIGN a RT Address to a Work Center 

Under Options select Assign RT Information the following prompt will appear: 
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Click on “Yes” to continue with the Setup process, or “No” to cancel. 

Machine Addresses 

Upon selecting “Yes,” the first thing that RealTimeTM does is check to see if any new machines have been 
added from Manufacturing. If there have been, it will bring up the first new machine to the screen. If no 
new machines have been added, it will bring up a pick list of all of the work centers and their existing 
addresses as shown below. The left side displays work centers and their current RT address assignment. 
The right side displays the available addresses. Addresses that are assigned to a work center already will 
display in yellow and the Assigned To field will show which work center(s) it is assigned to. 

 

This chart is to be used to help determine the machine address. 

Interface Board This is the board contained in the RT box. There can be either 4 interface boards, each with 
16 two-pin header connectors that connect to the machines, or two boards with 32 two pin 
header connectors each. 

Connect Location This is the designation of the two-pin header on the interface board. 

Machine Address This is the address that corresponds to the location of the two-pin header on the interface 
board. 
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To assign an Address to a center 

First, make sure the center to assign a RealTimeTM address to is highlighted. 

Next, select an address to assign to that center and press the “arrow over” button or double click to 
insert the address into the chart for that work center. The user can also drag and drop the address into 
the RT Address field. 

Scrap Address 

The scrap addresses are used for reversing or rejecting an input. When the system receives a scrap signal 
it is added to rejects and parts to go are increased. If the work center has an output that can indicate a 
Rejected Cycle, RT can collect the data for production reporting. However, RT cannot determine the type 
of reject, this will still need to be done manually from RealTimeTM on the 'Enter Part Reject and Attribute 
Data' form (accessed by selecting the Reject/Scrap entry button), or on the Production Report in the 
Rejects Reason field. The source in the reject table for a scrap entry captured by the MIU is RS. 

An additional MIU is required for reject signals unless the work center has a dry contact closure for this 
output. A contact closure is hooked up to the scrap address that tells the system that the whole cycle is 
scrap (not individual parts of a family tool). The system must still get a normal cycle signal even though it 
is a scrap signal. 

Depending on what input on the MMU is used for the reject signal, that input has an RT address and will 
be assigned to the work center as a Scrap Address in the RealTimeTM address board. Assigning the Scrap 
Address is done in the same manner as a RT Address (from the Work Center module as described above). 

Note: When adding the Scrap Address using the arrow button be sure the cursor is in the Scrap Address 
field or the RT Address will be overwritten. Assigning a Scrap Address does not consume an RT Scrap 
license, nor does it consume an RT Address license.  

Deleting or Editing a Center 

The RealTimeTM address information can be changed by using the technique described above. The 
address cannot be edited directly from the Address Set Up screen. 

To REMOVE a work center from RealTimeTM, it must be removed from the Assignment list. The 
'Connected to RTServer' and/or 'RTServer is not signaled', if applicable, must be un-checked on the work 
center.  
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Other Functions in the Work Center module 

User Fields 

There are five character fields and five numeric fields to enter additional information about the work 
center. 

User-Defined Form 

A User-Defined From can be created for the Work Center module. Please see User Defined Forms for 
details on creating the form. 

Documents 

Internal and external documents, and Email Correspondence can be associated to the work center on the 
Documents tab. Internal and External documents will also be visible from Shop Data. Documents can be 
set to print with a work order. 

Trace - Right Click from the header section to access the Trace option. 

RT Process Monitor Work Center Setup - Select the speed button at the top of the form to access this 
module. See the RT Process Monitor help files for details. 

Options Menu 

➢ Under Options on the menu bar, the user can: 

▪ Manufacturing Types - View or add additional manufacturing types from this screen. 

▪ View Manufacturing Cells - View or add in additional manufacturing cells from this screen. 

▪ Cost Elements- View or edit the cost elements table. 

▪ Assign RT Information- This is discussed in the Assigning the Work Center to RealTimeTM section. See 
Assigning the Work Center to RealTime. 

▪ Service Groups - Create service groups used in the RealTime Process Monitoring module.  Select the 
insert record button and enter the group description. Link the work center to the group in the 
Monitor Service Group field. 

▪ RTLabel Groups - Create RT Label groups used in the RT Labels Monitor module. Select the insert 
record button and enter the group description. Link the work center to the group in the RT Label 
Group field. 

▪ Shop Floor Disposition Parameters - see the section below Work Center Disposition Parameters. 

▪ Labor Cost Rate - This is the labor cost associated with this work center. This is used in conjunction 
with Time and Attendance and logging into a sales order. When in the Time & Attendance module, 
an employee logging in can select a sales order to put their time to. After selecting a sales order from 
the picklist then the work center picklist comes up. If a work center has a labor cost associated with 
it, the Time & Attendance will use this labor rate for the labor cost instead of the employees charge 
rate. This will be used in calculating the actual labor cost in process costing. 

▪ Assign Default Printer - This is used to define the default printer for a work center printing RealTimeTM 
labels using the RTLabel Monitor. This only applies to Crystal labels not LM labels. Reference the RT 
Labels Monitor https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Label-
Monitor.pdf TechNote for more information. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Label-Monitor.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Label-Monitor.pdf
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▪ MRO -  See the section below on MRO (Maintenance, Repair and Overhaul). 

▪ Association Manager - See the section below Association Manager. 

▪ Show CARs and ECOs - This will show open CARs , ECOs, MRBs and Deviations for the work center. 

▪ Where Used - This brings up a form showing the BOM’s that are attached to the work center type. It 
will display:  BOMs with a center type = work center center type regardless of MFG Type, and 
ASSY1/ASSY2 BOMs that have processes with a center type = work center center type. 

▪ User Defined Form - The User Defined form for work centers. The form can also be accesses by 
clicking on the User Defined From speed button. Refer to the User Defined Forms section on creating 
user defined forms for more information. 

Report Printing 

To print Reports, select Reports from the main menu bar within the Work center screen. 

▪ Selecting this function will bring up a dialog box listing all reports that are available for printing 
within this module. The reports can be printed to the workstation screen, sent directly to the printer, 
or printed to a file. 

 

Association Manager 

The Association Manager allows users to associate equipment with auxiliary equipment. This will enable 
the system to keep track of usage for all associated equipment. For example, a barrel and screw can be 
associated to a work center. When the production report is archived the work center, barrel, and screw 
will all automatically have the total units updated. The auxiliary equipment can be associated to multiple 
work centers. 
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To associate auxiliary equipment to a work center, find the work center in the tree. The list can be sorted 
by Equipment #, Equipment Description, or Equipment Class. Select the desired sort method from the 
drop down list or from the Options menu->Sort By. To search for a specific equipment select Search from 
the File menu and a picklist of equipment will appear. 

Once highlighted on the desired equipment, right click and select ‘Add Equipment’. Select the auxiliary 
equipment to add from the picklist. Continue this process until all auxiliary equipment has been added to 
the appropriate work centers. 

The Association Manager is also available in the Preventative Maintenance module. 

Other right click options from the Association Manager: 

Remove Equipment - This will remove the link between the auxiliary equipment and the work center. 
(This will not remove the equipment from the PM module). 

Where Used - This will bring up a picklist of equipment that the highlighted item is associated to. This 

option is also available from the speed button . 

Jump to Preventative Maintenance - This will jump to the Preventative Maintenance module for the 
highlighted record. 

Refresh - This refreshes the screen to display the latest information. 
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Checklists 

Checklists can be associated to work centers. The checklist will display when a setup is initiated on the 
work center from EIQ RealTime™, ShopData, and RTStation. Checklists can also be associated to BOMs 
and Assembly Processes. During a setup the web based Setup Checklist form will appear for the user to 
enter responses to the checklist items. If a BOM/Process and Work Center both have checklists the 
checklist will be combined on the same form with the Work Center's checklist listed first. A checklist 
history is stored for the work center or BOM/Process and can be reviewed at anytime, or used for 
reports. 

Note: This requires the IIS Server to be setup and the information populated in System Parameters-
>Company File Information tab->Web tab in order to view the web based checklist. See the IIS 
Installation TechNote https://my.iqms.com/cfs-file.ashx/__key/Technote/IIS-Installation.pdf for more 
information. 

Setup 

To begin to use the checklist functionality checklist templates will need to be created. Select the 'Setup 

Checklist Templates' button at the top of the Work Center module  to access the checklist for the 
work center. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/IIS-Installation.pdf
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From this form select the template button to access the pick list of checklist templates. Select the 'New' 
button on the pick list to create a new template. The Checklist Template form will display with a new row 
created for the user to enter the checklist information. 

 

Enter the data in the form. The top section is a description of the checklist. 

Checklist 
Description 

Enter the description of the checklist (up to 150 characters). 

Note Enter additional information about the Checklist (255 character limit). 

EPlant This will populate automatically based on the EPlant the user is logged into when 
the checklist is created. Users will only be able to see checklists for the EPlant they 
are logged into. 

Enter the actual checklist items associated to the highlighted checklist record. 

Sequence # The sequence of the checklist item. The sequence can be changed using the up 
and down arrow buttons. 

Text The description of the checklist item. This is a list of steps involved in completing 
the corresponding Checklist. 

Critical Check this box if the checklist item is critical. Critical items must have the status 
column on the checklist populated with Y, N, or N/A in order to complete the 
setup checklist. 
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Note A list of responses can be created which will apply to all checklist items. When the 
employee performs the checklist item they will be able to select from the drop 
down list, or manually enter a note (if allowed) in the Note field to further 
describe the outcome of performing the step. 

To create the list, right click and select 'Edit User Defined List'. Enter the list 
details in the text field. The Drop Down Style can be selected from the list: 

▪ Drop Down - Free form data entry. 

▪ Drop Down List - Predefined Text only. 

▪ System Default - Will be based on the setting in System Parameters 

Once the checklist template has been created it can be assigned to work centers. 

Assigning a Template 

From the work center where the template is to be applied, select the 'Setup Checklist Templates' button 
at the top of the Work Center module. Select the ellipsis button in the 'Setup Template Checklist' field. 
Select a template from the pick list. 

As setups are performed on the work centers with templates, the system will pop up the web based 
checklist for employees to respond to the checklist items. This will populate the Checklist History portion 
of the Setup Checklist form. 

 

Checklist History 

Setup Template 
Description 

This is the template description associated to the historical record. 

Setup Date The date/time the work order was setup. 

Work Order The work order number. 

Created On Date and time checklist record was created. 

Created By The user name that created the record. 

The checklist results 

Sequence # The sequence of the checklist item. 

Text The description of the checklist item.  

Critical This box is checked for a critical checklist item.  

Status  The status entered during the checklist process for the item. This will be 
populated with Y, N, or N/A. 

Note The checklist note entered by the employee. 
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Checklist 

During a setup the web based Setup Checklist form will appear for the user to enter responses to the 
checklist items. If a BOM/Process and Work Center both have checklists the checklist will be combined 
on the same form with the Work Center's checklist listed first. 
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Users can select Yes, N/A, or No for each question. There is also a comment field to enter notes for each 
checklist item. Once all of the checklist items have been addressed select the Submit Checklist button at 
the top. If a response is not entered for a critical checklist item (critical checklist items will have a red 
asterisk next to the number) upon submitting a popup with a Yes and No button will appear stating, 
'There are critical items on the checklist that are not marked with a decision. Continue?'.  If No is select 
the user is returned to the checklist to enter a response. If Yes is selected, or if there are no un-answered 
critical items, a message indicating the checklist has been submitted will display. Select Close to exit the 
checklist. The work order setup will then be completed. 

Checklist History 

The information entered from this form is visible from the Setup Checklist form in the Checklist History 
section. 
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Logical Work Centers 

For the Injection, Die Cast, Generic, Extrusion, Extrusion 2 and Extrusion 3 Manufacturing Types, or user 
defined types based on those MFG Types, an option is available in the MFG Types module (General tab) 
to enable Logical Work Center Support.  See Modifying  Manufacturing Types. 

Once this option is checked work centers associated to the MFG Type will have an additional tab called 
Change Over. From this tab work centers can be changed from a physical work center to a logical one 
and vice versa.  

Frames 

Frame Templates are created from the Work Center module. This is a list of the frames that can be 
selected when changing over from a physical work center to a logical one. Select 'Frames' from the File 
menu and the following form will appear: 

 

Enter all of the actual frames that can be utilized for insert molding.   

Frame # Enter the Frame number in this field. 

Description Enter the description of the frame. 

Tool Equipment 
# 

Select the ellipsis button in this field to access the Preventative Maintenance equipment form. 
Select an existing PM record from the pick list by selecting the 'Pick' button, or enter the 
information in the Equipment # and Description fields to add a new tool to Preventative 
Maintenance. 
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Frame Sets  In the lower section enter the frame set details.  

▪ Select the insert record (+) button and the Position # field will populate with the next sequential 
number starting with 1. 

▪ The Set Type will be used for the logical work center's Center Type. In the Set Type field select 
the drop down arrow and pick a set type from the list. This list will display center types 
associated to the logged in EPlant and those without an EPlant assigned.  

Change Over 

Once the set up steps are complete the logical work center functionality can be utilized. When the 
'Logical Work Center Support' option is enabled the work centers associated to that MFG Type will have 
an additional tab in the work center module called 'Change Over'. 
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Changing from a Physical Work Center to a Logical Work Center - When going from a Physical Work 
Center to Logical Work Center the Physical Work Center must not have work orders scheduled on it. If 
attempted the user will receive an error stating, "Work center is scheduled - operation aborted." To 

change over to a logical work center select the Change Over to a New Frame button . A 
confirmation box will appear, select Yes to continue. The pick list of Frames will appear to choose from. 
Select the frame that is set up in the physical work center. The information from the selected frame will 
populate in the corresponding fields (Frame #, Frame Description and Tool Equipment #).   

A logical work center will automatically be created for each frame set. In the example below a frame 
template with four frame sets was selected so the system created four logical work centers. The work 
center # is based on the physical work center number and frame number with a numeric value for each 
frame set (up to 60 characters). For example, Work Center # = 10, Frame = FR4-CR so the logical work 
center #'s will be 10-FR4-CR-1, 10-FR4-CR-2, etc. All information from the physical work center will carry 
over to each logical work center including user fields, optional elements, and documents. However, the 
Work Center Capacity will be empty and the Center Rate, Variable Costs and Fixed Costs will be prorated 
based on the number of logical work centers created. For example if the variable overhead rate is $25, 
four logical work centers would have a variable overhead rate of $6.25. 

When a primary material is associated to a change over the scheduling pool will be filtered to only show 
work orders that can be run on the center type associated to the logical work centers and that require 
that specific primary material. To associate a material select the ellipsis button in the field and choose a 
material from the Inventory pick list. If a material is not assigned users will see all work orders based on 
the logical work center type for any primary material. Note: This does not apply to the Generic MFG Type 
because Generic BOMs do not have a primary material. 

Scheduling is similar to the standard method. The logical work centers will be listed in the schedule 
instead of the physical work center.  If a primary material was selected on the change over tab only 
jobs using that material will be listed in the scheduling pool. Note: This does not apply to the Generic 
MFG Type because Generic BOMs do not have a primary material. 

For Logical Work Centers different work orders with the same BOM can be scheduled under the same 
‘Logical Work Center Group’ (logical work centers listed on the Change Over tab for the work center), but 
not in different ‘Logical Work Center Groups’. This is similar to physical work centers in that you cannot 
schedule different work orders with the same BOM on more than one work center. 

In Manufacturing Types there is an option available on the General tab called ‘Auto Substitute BOM’. 
When this setting is enabled, when attempting to add a work order to the first position, the system will 
look to see if the BOM on the work order is already scheduled in the first position on a logical work 
center. If the same BOM is already scheduled/running on a logical work center, and the user is trying to 
add it to a different logical work center then a substitute BOM will be created before adding the work 
order. A warning message will appear: “Attempting to schedule this work order on a different logical 
work center than the currently running BOM. If you would like to proceed, a substitute BOM will be 
created”. Users can select OK (to complete the action), Cancel (to abort this action), and there is also a 
“Do not show again” check box. Note: This option is visible on all MFG Types but will not affect anything 
unless the MFG Type also has 'Logical Work Center Support' enabled. 
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Reporting on production does not change in any significant way. You will notice additional records on the 
Production report itself, since each logical work center is treated as a unique work center during 
production reporting. 

Changing from a Logical Work Center to a Physical Work Center - When going from a Logical work center 
back to a Physical work center the Logical work centers must not be scheduled. If attempted the user will 
receive an error stating, "Some logical work center(s) are scheduled - operation aborted". To change 

over to a physical work center select the Change Over to a Physical Work Center button . A 
confirmation box will appear, select Yes to continue. All Logical work centers will be deleted. 

Note: In the case of Logical WC’s, the system creates/deletes work center records as the frames are 
added then removed for going back to a Physical WC. When creating a new work center the system 
determines available hours to be 24/7 instead of what is designated in the Shop Calendar.  The system 
can only recognize the specific shop calendar for the new work centers (Frames) for capacity planning 
purposes after the Set Default Calendar function is run, the schedule is updated, and RTServer must be 
stopped/re-started as well. 

For more information please see the Logical Work Center https://my.iqms.com/cfs-
file.ashx/__key/Technote/Logical_2D00_Work_2D00_Centers.pdf TechNote. 
 

Maintenance, Repair and Overhaul 

This option opens the Maintenance, Repair and Overhaul work center information as shown here. This 
option can also be accessed from the speed button. 

 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Logical_2D00_Work_2D00_Centers.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/Logical_2D00_Work_2D00_Centers.pdf
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There are two right click options available from the left-hand grid: 

▪ Jump to MRO Equipment - This feature is currently unavailable in this version of WebIQ. Please use 
EnterpriseIQ. From EIQ, this will open the Maintenance, Repair and Overhaul module for this work 
center. 

▪ MRO Work order References - This will display a list the Maintenance, Repair and Overhaul work 
orders associated to the equipment.  

The right click Jump to MRO Work Order feature is currently unavailable in this version of WebIQ. 
 

Optional Elements 

Select the Optional Elements speed button  to access the Optional Elements for where the user can 
enter an unlimited amount of work center elements and their sizes. This is for informational purposes 
only. 
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Reject and Downtime Codes 

Each Work Center can have specific reject and downtime codes associated to them. When displaying 
Reject and Downtime Codes in Shop Floor modules (RT Monitoring, RTStation, ShopData, IQRF and 
WMS) the system will display the sequential codes as follows: 

▪ If there are reject/downtime codes on the BOM Level the system will only show those codes 

▪ If there are reject/downtime codes on the Work Center level the system will only show those codes 

▪ If there are reject/downtime codes on both the BOM and Work Center levels both will be visible 

▪ If there are no reject/downtime codes on either BOM or Work Center levels all codes will display 
with soft filters on EPlant and the MFG Cell 

To associate the codes to a Work Center, select the Reject Codes or Downtime Codes tab. Click on the 
ellipsis button in the Code field to access the pick list. Only codes associated to the EPlant the user is 
logged into or null EPlant codes will appear in the list. There is also a soft filter on MFG Cell, where only 
the codes associated to the MFG Cell associated to the BOM or work center, or those with no cell will 
appear. Continue this process until all of the desired codes have been added. The sequence of the 
downtime codes can be changed using the up and down arrow buttons (this feature does not apply to 
reject codes). 
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Shop Floor Disposition Parameters 

This allows the user to establish the disposition locations to be based on the work center rather than at 
the inventory level. If the part is running on this work center and is auto-dispositioned, material will be 
taken out of the default location attached to the work center in the OUT Location field. If the IN Location 
field is also set up with a default location, this is where the manufactured product will be automatically 
dispositioned. 

 

Note: If the item has a location set up as a default location associated with the Mfg # or a default 
designator location the items will go into or be removed from that location and not the one associated 
with the work center. 

In summary the ‘hierarchy’ for auto dispositioning is as follows: 

The Auto Disposition Sequence: 

1 Hard Allocated to the work order  

2 Mfg # default designator 
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3 Default Designator 

4 Designated Work center location 

5 Mfg Cell Dispo location 

6 FIFO 

7 Temporary 
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Parameter Settings List: 

IN Transaction - Select the location for IN Transactions for this work center from the drop down list. 

Inventory Pickup Threshold - These settings are used  for the system to compare the Dispo In items -> 
BOL Data -> Package or Pallet Items per (depending on the listed Default Packaging Type) to the quantity 
of items in the Dispo IN location.  If the Dispo IN location Qty has any Pickup rows in TRANS_ALERT for 
this item that are greater than the Work Center based Inventory Pickup Threshold the system will add a 
row to TRANS_ALERT with: INV_ZONE_ID = the Dispo In LOCATION.WK_INV_ZONE; TRANS_IN_OUT = 
OUT; ALERT_DESCRIP = “Pickup XXXXXX from LLLLL” where XXXX = the Items Description and LLLL = the 
LOC_DESC. 

▪ Priority - The choices are: 1= High Priority, 2= Med Priority and 3= Low Priority 

▪ # of Packages 

▪ # of Pallets 

When 'Automated Directed Task Generation' is enabled, the system will automatically generate a 
directed Pickup Request task whenever the number of pallets or packages reaches the 'Inventory Pickup 
Threshold' for the work center. Directed tasks will only be generated automatically if the system can find 
a successful transaction plan for the case in which the inventory pickup threshold is hit.  

The system uses the following formula to determine when a task will be generated automatically:  

If (Quantity of Packages/Pallets at the Pickup Location) - (Sum of All TRANS_ALERT Pickup Tasks for the 
Location) is Greater Than or Equal To the Package or Pallet Threshold, then a directed Pickup task will be 
generated automatically. 

OUT Transaction - Select the location for OUT Transactions for this work center from the drop down list. 

Staging Qty (hours) - This is the number of hours the system will use to determine the staging quantity of 
materials required for the 'Work Order Materials & Components' module (ShopData and Assy Data). This 
defaults to 8 hours but can be changed from this field or a specific value can be assigned to a work 
center that will override the default. 

▪ Default 

▪ This work center 

The system uses the lesser result of the two following equations to determine the staging quantity. 

1. (Hours to Go) * (Cycles Per Hour) * (Cavities Per Shot) = Staging Qty 

2. (Staging Hours) * (Cycles Per Hour) * (Cavities Per Shot) = Staging Qty 

The variables are defined as follows:  

Hours to Go = (Shots Required) / (Cycles Per Hour - visible in RealTime and ShopData Work Order 
Materials and Components as 'Hours to Go') 

Cycles Per Hour = (3600 / (Cycle Time)) * (Efficiency Factor - visible in the BOM Production Summary 
module as 'Net Cycles/Hr') 
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Shots Required = (Work Order Quantity) / (Cavities Per Shot) 

When 'Automated Directed Task Generation' is enabled and the 'Staging Qty (Hours)' exceeds the total 
run time of the work order, the system automatically generates directed Staging tasks for the work 
order's full amount.  

When the 'Staging Qty (Hours)' is less than the total run time of the work order, then the system 
generates directed Staging tasks for only the partial amount required to generate the work order. 

Note: It is recommended that users clear material from the staging OUT location before generating a 
directed staging task - this will prevent users from bringing too much material to the staging OUT 
location. The 'Materials Required' value is based on RealTime information, so it does not account for any 
pre-staging or leftover material in the staging OUT location. This may cause users to incorrectly think 
that the staging OUT location has more capacity when it's actually full. 

Disposition all Hard Allocated raw material when work order is marked "Prod Finished" - This option can 
be set at the Work Center level so that when materials are backflushed for a work order that has been 
marked 'Prod Finished' either by selecting 'Workorder xxx is finished' when performing a setup in 
RealTime™ or Scheduling, or when it is manually checked in the production report, all hard allocated 
materials will be removed from inventory instead of the calculated required quantity. For example, if the 
quantity hard allocated is 1500 and the required quantity based on what was manufactured is 1250, the 
system would remove the 1500 when this is checked, if not checked it would remove 1250. 

If some required material was not hard allocated the system will calculate the material usage using the 
standard method, i.e. by evaluating total cycles and parts counted, etc. 

The system will look at the Work Center/Manufacturing Cell that the work order actually ran on when 
verifying whether or not the options are checked. This also applies to Non-RealTime Production 
Reporting by Shift (PRS). If a work center/Manufacturing Cell is selected that differs from the one the 
BOM has assigned, the Work Center/Manufacturing Cell in PRS will be used. 

There are three options that can be selected from the drop down list: Yes, No, and System Default.  

▪ Yes - When Yes is selected the option is enabled at the this level. 

▪ No - When no is selected the option is not enabled at this level and the system will not continue 
looking at the hierarchy. 

▪ System Default - By default it is set to 'System Default'. If system default is selected the system will 
evaluate the hierarchy.  

A mouse-over hint is available when hovering on the setting that will let the user know which level of 
hierarchy will be used for both options (Disposition all Hard Allocated... and Freeze Consumption...), and 
what the values are. For example, "All hard allocated materials will be consumed. Consumption beyond 
hard allocated will not be frozen. Hierarchy Level = System". 

The hierarchy for this option is: 

1 Work Center 

2 Manufacturing Cell 
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3 Manufacturing Type 

4 Production Reporting by Shift Parameter 

Note: This feature is available for all MFG types except ASSY2, ASSY3, and COMPLEX. 

Freeze consumption beyond hard allocated - This option will be available if the 'Disposition all Hard 
Allocated raw material when work order is marked "Prod Finished"' option is checked. If this option is 
enabled and 'Prod Finished' is checked for the work order, the system will not consume more material 
than what was hard allocated. 

Note: When dispositioning the item the system will show material/components that were not hard 
allocated to the WO and only freeze consumption of material/components that were hard allocated but 
have been brought to zero through Return to Inventory or consumption. 

Automate Directed Task Generation - This option, if enabled, activates automated directed task generation 
at the work center level. If the system-wide 'Automated Directed Task Generation' has been enabled 
within the Directed Task Monitoring module, this setting doesn't matter - tasks will be generated 
automatically for all items and all work centers. If the system-wide setting has not been enabled, 
however, this setting confines the automated directed task generation functionality to only this work 
center. 

Note: The 'Materials Required' values may get miscalculated if RealTime is already receiving cycle 
information when the work order for the BOM is loaded into first position.  

Note: Directed tasks will not generate if Auto Load has scheduled the associated work order into first 
position. 
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Virtual Work Centers 

Work centers in EnterpriseIQ can be set up as virtual work centers. This enables the user to schedule and 
run the same manufacturing number on several work centers at one time. The system will recognize that 
the actual work centers are associated to a virtual work center and will divide the quantity to 
manufacture across the associated work centers. The current status of the virtual work center and its 
associated (child) work centers are visible in RealTimeTM and the all the data flows to the production 
report as a combined value for the virtual work center. After a production report is archived the 
associated work centers are visible in the archived report and the total units in MRO are updated for 
each. 

Virtual Work Center Set Up 

Several steps need to be made prior to using the Virtual Work Center functionality in EnterpriseIQ. 

System Setup 

The first set up step is to tell the system to incorporate the virtual work center functionality. From the 
Sys Setup tab select the System Parameters module. Select the Company File Information tab and then 
the Application tab. Check the option, "Incorporate Virtual Work Centers / Work Orders". 
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Work Centers 

Select the Work Centers module on the Mfg Tab. To create a new virtual work center select the New 
button from the work center picklist or select the Insert (+) button from within the work center module. 
A blank work center form will appear. Enter the work center description information including the work 
center #, Description, Center Type, etc. just as you would for any new work center. 

From the File menu select 'Virtual Work Center'. This will tell the system that this work center is a virtual 
work center and an additional tab called Virtual will appear in the lower section. 
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From the Virtual tab the user will associate the actual work centers that make up the virtual work center. 
Actual work centers can be added by cloning the virtual work center or by selecting existing work centers 
from the picklist, or a combination of both methods. 

Clone Virtual Work Center - To create the work center by cloning the virtual work center, select the clone 

button  in the lower section. A pop up box will appear to enter the work center #. All of the other 
information will be copied from the virtual work center such as Description and Center Type but they can 
be edited by typing over the information in this section. 

Associate Existing Work Center - To associate an existing work center, select the Insert (+) button or 
double click in the Work Center # field to access the work center picklist. Select the desired work center 
from the list. If a work center has work orders scheduled on it, the work center will not be able to 
associated with a virtual work center. A message will appear that states, 'This work center has work 
orders scheduled. Remove work orders from schedule for this work center and try again'. 

Continue this process until all of the associated work centers have been attached to the virtual work 
center. 

Note: Adding a new child work center to a virtual work center while a job is running will not affect the 
currently running job. The next job setup will be divided by the number of child work centers associated 
at the time of setup. 

RealTimeTM Addresses and RT Server 

The RealTimeTM addresses are always assigned to the associated (child) work centers and not the virtual 
work center. If an existing work center with a RealTimeTM address was attached to the virtual machine, 
that address will populate the RealTimeTM address field on the Virtual tab. If a new work center was 
created the user will need to check the 'Connected to RT Server' option and then assign the work center 
a RealTimeTM address by selecting 'Assign RealTime Information' from the Options menu. 

Note: The work centers that have been associated to a virtual work center are no longer visible in the 
work center pick lists throughout the system (such as scheduling). 

The virtual machine does not need a RealTimeTM address but it must have the 'Connected to RT Server' 
option selected in the RealTimeTM Information section on the General tab in the Work Center module. 
The center RealTimeTM Address will automatically populate with the first associated work center's 
RealTimeTM address with a "_VIR_ " during job setup and not when the associated work centers are 
created. 

Disassociate from Virtual Work Center - A child work center can be disassociated from the virtual work 
center by selecting the (-) button in the associated work centers section of the form. Select the 
disassociate option to remove the work center from the virtual machine. To delete the work center 
completely select the 'Delete Associated Work Center'. 

Bill of Manufacture 

BOM's that will be run on virtual work centers should be marked as a Virtual BOM. Once a BOM is 
marked virtual an additional field will be visible to enter the number of work centers that will be running 
this configuration at the same time. This option is only available for Injection or Generic BOM's. 
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To mark the configuration as a Virtual BOM, select 'Virtual BOM' from the File menu on the bill of 
manufacture. Once this option is selected the Virtual BOM Multiplier field will become visible. Enter the 
number of work centers that will run this configuration at the same time. This field will affect the 
Cycles/Hr, Hours/K Cycles and Net Cycles/Hr. This production summary information is used by the 
system to determine the production hours required for a work order, which in turn affects the must start 
date. This information is not used in scheduling; if the BOM's Virtual BOM Multiplier is set to 10, but the 
work order is scheduled on a work center with 3 virtual work centers, the system will divide the work 
order by 3 instead of 10. For more information please see Virtual BOM. 

Using Virtual Work Centers 

Scheduling 

Once the setup is complete the user can begin to use the virtual work center functionality. When 
demand is present for items that will be run on virtual work centers, work orders are created in the same 
manner as other demand. As mentioned earlier the production hours are calculated based on the 
Cycles/Hr which is affected by the Virtual BOM Multiplier value in the configuration. 

The work order is scheduled to the virtual work center, not the associated work centers. (Only the virtual 
work centers are visible in the work center picklist in the schedule). The job is scheduled in the typical 
manner. When the work order is in any position other than the first position the Hours To Go will be 
calculated as: ((net cycle time * cycles required) / Virtual BOM Multiplier). 

If the job is in the first position the hours to go is calculated: (standard cycle time * cycles required) / 
actual number of work centers associated to virtual machine. 

RealTimeTM 

Once the work order is scheduled it can be viewed from RealTimeTM. The virtual or associated (child) 
work centers will not be visible upon first opening the RealTimeTM screen. To view the virtual machines 

select the button  'Show only virtual work centers'. The screen will change to display only virtual 
work centers in the top section and the associated work centers in the bottom section. The information 
displayed for the virtual machines in the top section will be based on the selected view (Part Numbers, 
Quality Control, etc.). Changing the view on the parent does not affect the view for the associated work 
centers. The information displayed for the children is always the Part Number view. 

The virtual machine is the sum of all the child machines. It accumulates all of the cycles made on all the 
children and shows the 'parts-to-go' for the entire run. The virtual machine will be the deciding factor as 
to whether the 'run' is done. The running child machines will run into the negative to compensate for a 
machine being down. 

RealTimeTM Production Data Entry 

All production data entry, such as rejects and downtime, is entered on the virtual machine. There are no 
right-click options on the associated work centers. The procedure for entering the production data is 
identical to that for non virtual work centers. Please refer to the RealTimeTM help files for more 
information. 

Production Reporting 
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In the production report, users will see the parent virtual work center but not the associated child work 
centers.  However, all of the child work centers will have data in the DAYPROD table, and information 
for them may be viewed by right-clicking the parent and choosing the option View Associated 
Workcenters. For the parent work center, the system combines the total cycles, total good parts and 
production hours from all of the child work centers to arrive at the parent virtual work center’s totals.   

Upon production report disposition, the system will update the Total Units in Maintenance, Repair and 
Overhaul (MRO) for the child work centers only, the parent virtual work center will be ignored since 
there is no PMEQMT row associated to it. 
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Shop Setup 

The Shop Calendar is where the number of shifts and their times are set. This information assists in 
determining work center capacity, scheduling, material planning, production shift reports, etc. In 
addition, the values entered here are used to tell RealTimeTM when to stop counting production against 
one shift and begin counting against the next and auto-generate a production shift report. The Shop 
Calendar uses values stored in this section to create a default calendar. The default schedule is the most 
generic schedule that your shop may have. For example, your plant may generally run 24 hours per day, 
three shifts, five days per week. However, several machines may actually run over weekends or through 
holidays. Using the Shop Calendar, these exceptions can be created and maintained. For EPlant users, a 
default shop calendar can be set up per EPlant. Specific shop calendars can also be set up for 
Manufacturing Cells. When determining the current shift, the system first looks to the Manufacturing 
Cell. If no custom calendar exists for the cell, it then looks to the EPlant. If there is not a default set up for 
the EPlant it uses the System Default calendar. 

Shop Calendar can be accessed from one of the following two ways: 

▪ From the EIQ Launcher Bar, click on Shop Set Calendar icon , or 

▪ From within the Scheduling screen, click on Options|Shop Setup. 

Shop Setup must be completed prior to scheduling any work orders. This section is used to define the 
following: how many shifts per day are being run, shift start times, and the number of days per week 
that the work center(s) (manufacturing or generic) will be in operation. Enter the number of days per 
week and which shifts are working for Manufacturing and Generic work centers. The shifts are then 
assigned to valid work centers. 
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The values entered here are used to tell RealTimeTM when to stop counting production against one shift 
and begin counting against the next. At the end of each shift, a production report is created, which 
maintains a summary of production history for the prior shift. 

To ENTER information into these sections, complete the following steps: 

Select the Source to create the calendar for (System Default, or a specific EPlant). 

➢ Enter in the number of shifts that will run in a 24 hour period, the time each shift starts, and 

the Manufacturing and Generic center information. Make sure that all of this information has 

been entered before setting up the calendar. Below is a field listing describing each field in 
detail. 

NOTE: RealTimeTM assumes a standard 24 hour production day with regular shift changes. If your shop 
uses a unique shift schedule, try to set up this information with this in mind, but that which comes 
closest to matching your schedule. 

Default Shop Setup Field Listing: 

# of Shifts The number of shifts that will run in a 24 hour period. 
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Hours Per Day The number of hours per day the plant is running. 

MFG Days/Week Enter the number of days per week that the Manufacturing centers will be operating. 

Select the Define Working Shifts speed button  to designate specific days per week 
working. 

  

For a five day week the form will default to Monday through Friday. Users can check or 
un-check the boxes to fit their default working days. 

Generic Days/Week Enter the number of days per week that these centers will be operating. 

First Shift 

Second Shift 

Third Shift 

Fourth Shift 

Fifth Shift 

Enter the time that each one of these shifts start. The time entry must be based off the 24 
hour clock. 
12 AM = 00:00:00, 1 PM = 13:00:00, 8 PM = 20:00:00. 

Working Select the number of shifts worked per day for Mfg and Generic work centers. 

Disable RealTime 
Shift Report 

Checking this box will prevent the system from writing to the xdayprod table such as 
during shift change, removing job, change of lot etc. The rest will continue functioning 
exactly as before. With this checked users should create one shift 24 hrs long to prevent 
the production reports from being created. This option can be set up for a specific MFG 
Cell. 

 
 



Initial Data Entry Page 79 of 91 

 

Shift Examples 

When creating a shift calendar keep in mind that the production date is set for all three shifts when the 
first shift starts. The production date remains unchanged until the next first shift. 

The following examples demonstrate how the production date will be affected depending on the first 
shift’s start time. 

Example One: 

First shift starts at 7:00 a.m. each shift works five days per week. 
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Based on the shop calendar example above the production shift reports will be created by RealTimeTM as 
follows: 

Sunday, Shift 3 (dated Sunday’s date) 

Monday - Thursday, Shift 1,2, and 3 (All three shifts will be dated the date for 1st shift). 

Friday, Shift 1,2, no shift 3 (assuming shift 3 does not work on Friday’s. Both shifts will have Friday’s 
date). 

Example Two: 

First shift starts at 11:00 p.m. and all shifts work five days per week. 

 



Initial Data Entry Page 81 of 91 

 

Based on this shop calendar the production shift reports will be created by RealTimeTM as follows: 

Sunday, Shift 1, 2, and 3 (all will have a production date for Sunday but shift 2 and 3 are actually working 
on Monday). 

This will be the same for the rest of the week which can be very confusing. If Shop Calendar is set up like 
the second example, with the first shift starting at 23:00 then shift 2 and 3 will always have “yesterday’s” 
date. 

NOTE: The production date (PDATE) is set for all three shifts when the first shift starts. The PDATE 
remains unchanged until the next first shift. 

Two Shift example 

If your shop is only running two, three, or four shifts that do not add up to 24 hours and you are using 
RealTimeTM be sure to enter a third shift for zero hours if there are only two actual shifts, or a fourth shift 
for zero hours if there are only three actual shifts, or a fifth shift for zero hours if there are only four 
actual shifts, . This is necessary to let RealTimeTM know when the second shift ends. 

➢ To do this set the # of Shifts to 3, 4, or 5 (one more than actual) and the Hours/Day to 16. 
In the example: 

Shift 1 starts at 7:00 for 8 hrs 

Shift 2 starts at 15:00 for 8 hrs a day 

Shift 3 starts at 23:00 for 0 hrs a Day. 
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Manufacturing Cell and Work Center Setup 

Manufacturing Cell Setup 

If you are using separate cells, you can setup individual shift information for each cell. Enter the number 
of shifts, hours per day that each cell works, and the number of days per week. Then enter the actual 
start times of each shift. The Default days/week value has to be greater to or equal to the days/week for 
the cells. If your default calendar is working five days per week then all of the cells have to be set at the 
default or if they have unique shifts they must all be working five days or less per week. 

The green arrow button will bring over the default information you set on the default tab if the 
information for the cell is the same as the default. 
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Disable RealTime Shift Report - Checking this box will prevent the system from writing to the xdayprod 
table such as during shift change, removing job, change of lot etc. The rest will continue functioning 
exactly as before. With this checked users should create one shift 24 hrs long to prevent the production 
reports from being created. This option can be set up on the default calendar. 

Note: for RealTimeTM users: If a cell requires a dedicated shift change it will run in a separate database 
session. To support a separate database session per shift, change the BDE Shared Memory Size to 8192 
or higher. Failure to do so will result in insufficient memory errors. 

Clearing Individual Shift Information - To remove the specific shift information and return to the defaults, 
select the minus button. A confirmation message will appear, 'Are you sure you wish to revert to Default 
Schedule?', select Yes to clear out the settings or No to keep them. If a user attempts to clear out the 
information manually by backspacing over the data in the fields, when attempting to post the change a 
warning will appear stating, 'Field '# of Shifts' must have a value.' 

Work Center Setup 

The number of shifts, hours per day, and days per week can be setup at the Work Center level. The # 
Shifts and Hours/Day cannot exceed the default # Shifts and Hours/Day. The default is determined based 
on the hierarchy: 

▪ If the work center belongs to a manufacturing cell with a specific setup then this setup becomes the 
default. 

▪ Otherwise the system will use default setup from the Default tab. 

Note: This change will only affect Rough Cut Capacity -> Work Center Type -> Hours Available. It will not 
affect the schedule. 

Note: This information will not be used to calculate Work Order Must Start Date as it is not known which 
work center will be used to run the work order or process.  

Note: When Down Time is added to a work center that has it's own Shop Calendar set up, the Down Time 
will use the work center's Shop Calendar available hours to determine the End Time. 

Enter the number of shifts, hours per day that each work center works, and the number of days per 
week. Note: By design the shift setup does not include start/end times for the shifts. 
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To generate the calendar for just one work center, assign # Shifts, Hours/Day, Days/Week, then right 
click and select 'Set calendar for selected work center'. The work center specific calendar is also 
generated during the 'Set Default Calendar' processing. 

To delete a calendar setup assigned to a work center clear out # Shifts, Hours/Day, Days/Week. 
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Set Calendar 

This option recreates and stores weekends/off shift information according to the parameters setup 
under Shop Setup. If the user exits without updating the calendar a warning will display to remind them. 

To setup the Shop Calendar: 

➢ From within the Shop Setup screen, click on Calendar/Set Default Calendar. 

➢ Enter the year in which the weekends/off shift information will be created for. 

➢ Click on [OK] to continue. The system will go through and setup the default shift information 

based on what was entered under Shop Setup. Upon completion, the user will be notified 
that the transaction was completed successfully. 

➢ Click on [OK]. The user will be returned to the Shop Setup screen. 

If the user has only changed the information for a specific cell the Set Default Calendar function can be 
done for just that cell instead of the entire shop calendar. To perform the update for a specific cell 
highlight the cell then right click and select Set Calendar for Selected Mfg Cell. 

NOTE: In addition to updating the calendar after changes have been made, RealTimeTM users will also 
have to restart the RT Server to recognize the changes. Restart RT Server after the Set default Calendar 
has been run. 
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Creating Holiday Periods 

EnterpriseIQ must know when the entire facility or individual work centers will not be operating. The 
Holidays option supports the setting of these parameters. 

➢ From within the Shop Setup screen, click on Calendar/Add Holidays and the following screen will 

appear: 
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The system works by exclusion - entering a date or date range in the Period section will exclude those 
dates from production consideration. The user can use this tool to exclude as many time frames as 
necessary. If the Holiday is just one day be sure to include a time as well. To enter a time arrow over to 
the right of the date field in the From and To fields. 

Note: Assigning time off in Holidays and applying it to the default calendar will adjust the must start 
dates on work orders so that they are not starting on a regularly scheduled holidays. If a user just edits 
the shop calendar by adding or deleting time or using the 'Schedule Days Off' option, the must start date 
could calculate to start on an off day. 

The Apply To section is used to specify the work centers to be affected. If the ‘All Work Centers’ box is 
checked, all work centers at the facility will be affected by the holiday time. If this box is not checked, 
then the user can select which work centers to apply the holiday to by highlighting them in the list using 
the toggle buttons or the Shift and Ctrl buttons on the keyboard. This table can be sorted by any column 
to help locate the specific records to be included. For example, if the holiday is for a specific EPlant select 
the EPlant ID column to sort the list based on EPlant and then select the work centers associated to just 
the plant where the holiday should be applied. 

The Start and End rows in Schedule Days Off will show in green. 

Note: If a holiday is added incorrectly, the user can select the Default Calendar option to revert the 
calendar back to the default. This process will remove them from the MFG Cell tab and the Work Centers 
tab. 

Note: On the day that daylight savings time begins there will be no 2AM hour. To prevent errors the 
system will automatically skip over the time change and will not allow jobs to be scheduled during that 
hour. 
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Schedule Days Off 

You can further adjust the shop calendar by going to Schedule Days Off under Calendar/Schedule Days 

Off. Note again that the Schedule Days Off option will not effect the Must Start dates, only holidays 
assigned to the default calendar will. When the system is calculating the must start date, it does not 
know which work center it will run on, so therefore could not use specific work center off days. The Start 
and End times in the schedule will be adjusted by the Scheduled Days off. This screen shows all of the 
days off that have been scheduled to each work center through the previous set up. The Start and End 
rows in Schedule Days Off will show in green for holidays. You can go into this screen and delete days off 
already assigned or add other days off to each work center or based on a manufacturing type or cell by 
using the navigator bar +/- buttons. 

Note: When adding time off on the MFG Cell / MFG Type tab the ‘Propagate to work centers’ option 
must be checked before adding the time block in order to have the time off propagate to the associated 
work centers. If this option is checked and time off is removed it will also delete the days off for each 
work center in the cell.  

Note: If a time off period is edited by increasing the date range and the change is posted it will propagate 
to the work center(s) if the box is checked. However, if the range is then shortened again the work 
center will still show the longer date range. This is due to the system merging the off periods for the 
work center calendar to avoid duplicates. When a user shortens a down period the system sees it as a 
duplicate that is covered by a longer interval and ignores it.  

To delete multiple days off from the list associated with work centers click on the Multi-Select 
button. With multi-select on the user can select multiple records then click on the Delete (-) button to 
remove the days off for the highlighted work center. 

To add days off the user can click on the ADD (+) button then type in the day and time in the start and 

end fields or use the Edit Start/End time button  to enter the date and times on the form: 
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Time Off by Shift 

Use this feature to define the “working shifts” on selected work centers. This will over-ride “working 
shift” settings found on the Default Calendar. 

Select the work centers the time off is to be set for on the Schedule Days Off form. To multi-select work 

centers hold down the SHFT or CTRL key. Then click on the Shift Time Off speed button  or go to 
Calendar/Assign Time Off by Shift. 

 

Select the date range for the time off and check the shifts that will be working if any. If the Working 
shifts check boxes are blank, the system will add time off for all shifts for all the work centers previously 
selected, for the date range. 
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